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Changes

Barco provides this manual ’as is’ without warranty of any kind, either expressed or implied, including but
not limited to the implied warranties or merchantability and fitness for a particular purpose. Barco may make
improvements and/or changes to the product(s) and/or the program(s) described in this publication at any
time without notice.

This publication could contain technical inaccuracies or typographical errors. Changes are periodically made
to the information in this publication; these changes are incorporated in new editions of this publication.

The latest edition of Barco manuals can be downloaded from the Barco web site www.barco.com or from the
secured Barco web site https://www.barco.com/en/signin.

Copyright ©

All rights reserved. No part of this document may be copied, reproduced or translated. It shall not otherwise
be recorded, transmitted or stored in a retrieval system without the prior written consent of Barco.

Guarantee and Compensation

Barco provides a guarantee relating to perfect manufacturing as part of the legally stipulated terms of guarantee.
On receipt, the purchaser must immediately inspect all delivered goods for damage incurred during transport,
as well as for material and manufacturing faults Barco must be informed immediately in writing of any com-
plaints.

The period of guarantee begins on the date of transfer of risks, in the case of special systems and software on
the date of commissioning, at latest 30 days after the transfer of risks. In the event of justified notice of complaint,
Barco can repair the fault or provide a replacement at its own discretion within an appropriate period. If this
measure proves to be impossible or unsuccessful, the purchaser can demand a reduction in the purchase price
or cancellation of the contract. All other claims, in particular those relating to compensation for direct or indirect
damage, and also damage attributed to the operation of software as well as to other services provided by Barco,
being a component of the system or independent service, will be deemed invalid provided the damage is not
proven to be attributed to the absence of properties guaranteed in writing or due to the intent or gross negligence
or part of Barco.

If the purchaser or a third party carries out modifications or repairs on goods delivered by Barco, or if the
goods are handled incorrectly, in particular if the systems are operated incorrectly or if, after the transfer of
risks, the goods are subject to influences not agreed upon in the contract, all guarantee claims of the purchaser
will be rendered invalid. Not included in the guarantee coverage are system failures which are attributed to
programs or special electronic circuitry provided by the purchaser, e.g. interfaces. Normal wear as well as
normal maintenance are not subject to the guarantee provided by Barco either.

The customer must comply with the environmental conditions as well as the servicing and maintenance regu-
lations specified in this manual.

Trademarks

Brand and product names mentioned in this manual may be trademarks, registered trademarks or copyrights
of their respective holders.

All brand and product names mentioned in this manual serve as comments or examples and are not to be
understood as advertising for the products or their manufacturers.

Terms and Conditions

1. No redistribution of the software is allowed.
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2. Reverse-Engineering. You may not reverse engineer, decompile, disassemble or alter this
software product.

Disclaimer of Warranty

This software and the accompanying files are sold “as is” and without warranties as to performance or mer-
chantability or any other warranties whether expressed or implied. In no event shall Barco be liable for damage
of any kind, loss of data, loss of profits, business interruption or other pecuniary loss arising directly or indirectly.
Any liability of the seller will be exclusively limited to replacement of the product or refund of purchase price.

Federal Communications Commission (FCC Statement)

This equipment has been tested and found to comply with the limits for a class A digital device, pursuant to
Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential area may cause
harmful interference, in which case the user will be responsible for correcting any interference at his own ex-
pense.

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s
authority to operate the equipment.

EN55032/CISPR32 Class A Multimedia Equipment

Warning: This equipment is compliant with Class A of CISPR 32. In a residential environment this equipment
may cause radio interference.

Product Modification Warning

High End Systems products are designed and manufactured to meet the requirements of United States and
International safety regulations. Modifications to the product could affect safety and render the product non-
compliant to relevant safety standards.

Mise En Garde Contre La Modification Du Produit

Les produits High End Systems sont conçus et fabriqués conformément aux exigences des règlements interna-
tionaux de sécurité. Toute modification du produit peut entraîner sa non conformité aux normes de sécurité
en vigueur.

Produktmodifikationswarnung

Design und Herstellung von High End Systems entsprechen den Anforderungen der U.S. Amerikanischen
und internationalen Sicherheitsvorschriften. Abänderungen dieses Produktes können dessen Sicherheit beein-
trächtigen und unter Umständen gegen die diesbezüglichen Sicherheitsnormen verstoßen.

Avvertenza Sulla Modifica Del Prodotto

I prodotti di High End Systems sono stati progettati e fabbricati per soddisfare i requisiti delle normative di
sicurezza statunitensi ed internazionali. Qualsiasi modifica al prodotto potrebbe pregiudicare la sicurezza e
rendere il prodotto non conforme agli standard di sicurezza pertinenti.

Advertencia De Modificación Del Producto

Los productos de High End Systems están diseñados y fabricados para cumplir los requisitos de las reglamenta-
ciones de seguridad de los Estados Unidos e internacionales. Las modificaciones al producto podrían afectar
la seguridad y dejar al producto fuera de conformidad con las normas de seguridad relevantes.
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製品変更に対する警告

High End Systems 製品はアメリカ合衆国及び、国際安全基準の必要条件を満たすよう設計及び製造されてい
ます。この為、製品に対する変更は安全に対して影響を及ぼす場合及び、関連安全基準に満たない状態にす
る場合があります。

Barco Pn: 60600320



Declaration of Conformity
Barco Lighting Systems Inc.Manufacturer's Name:

2105 Gracy Farms Lane
Austin, Texas 78758 USA

Manufacturer's Address:

Barco Lighting Systems Inc.Distributor's Name:

2105 Gracy Farms Lane
Austin, Texas 78758 USA

Distributor's Address:
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(RoHS).
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Section 1: Introduction

Barco® Media Servers are fully integrated visual production systems that enable video
professionals to easily develop their show from idea to realization. Allowing users to
quickly and easily set up, preview, and manage their show environment, they form the
perfect connection between the creative ideas and the display systems that bring them
to life.

Barco couples its media server hardware with the X-Agora™ software suite. This software
is scalable, compatible with popular media formats, supports connectivity with various
sensors and input, and makes it possible to deploy content onto the most challenging
surfaces with an advanced yet easy-to-use projection mapping tool. Its interactive media
system captures and processes data in real-time, creating interactive media content for
various types of displays.

1.1 About this guide

1.1.1 This guide

This user guide describes how to operate a Barco Media Server. The user guide is de-
signed to be a reference tool in the everyday work of the user with the product. It contains
a complete description of the hardware components and the software suite. The
manual also includes all the necessary instructions on how to upgrade and reinstall the
software.

Note

Barco provides a 1-year parts and labor warranty for all hardware compon-
ents. Please refer to the Appendix B, "Warranty," for specific details regarding
the warranty terms.

1.1.2 Available system documentation

This guide is part of the documentation set describing the Barco Media Server product.

Please check online at the Barco Media Server website for the other documents.


Tip

Always check for the latest version of all documents on the Barco website.
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1.2 Symbols, pictures, and fonts

1.2.1 Symbol overview

The following icons are used in the manual:

!
Caution

This symbol appears adjacent to Caution messages. Not heeding these
messages could result in personal injury and/or damage to equipment.

Warning

This symbol appears adjacent to high voltage warning messages. Not
heeding these messages could result in serious personal injury.

i Info

This symbol indicates a term definition or general information about a term.

Note

This symbol appears next to extra information about the described subject.


Tip

This symbol appears next to extra advice about the described subject.

1.2.2 Picture overview

Images and pictures given in the manual are used as illustration. The content of the
images can be slightly different from reality, e.g. version numbers, device types, installed
modules, form and position of software windows on screen, etc.

1.3 Standards and safety
This section lists standards that apply to Barco Media Servers and describes safety
precautions that must be observed when installing and operating a product from Barco.
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1.3.1 General safety instructions

• Read this manual thoroughly before operating this equipment.

• Adhere to all warnings in this manual.

• Follow precisely all instructions for operating and use of this equipment.

• Adhere to all local installation codes.

• Retain this manual for future reference.

For further safety information see the Barco Media Server XHD-Series Safety Guide.

1.3.2 Standards

Safety regulations

This equipment is built in accordance with the requirements of the international safety
standards EN60950-1, IEC60950-1, UL60950-1, and CAN/CSA C22.2 No.60950-1, which
are the safety standards of information technology equipment, including electrical
business equipment.

These safety standards impose important requirements on the use of safety critical
components, materials, and insulation, in order to protect the user or operator against
risk of electric shock and energy hazard and having access to live parts.

Safety standards also impose limits to the internal and external temperature variations,
radiation levels, mechanical stability and strength, enclosure construction and protection
against the risk of fire.

Simulated single-fault condition testing ensures the safety of the equipment to the user,
even when the equipment’s normal operation fails.

Electromagnetic interference

Barco Media Servers comply with the following EMC standards:

Electromagnetic compatibility
—emission:

EN 55022: (2010)

EN 61000-3-2 (2006) +A1 (2009) + A2 (2009)

EN 61000-3-3 (2008)

Electromagnetic compatibility
—immunity:

EN 55024 (2010)

EN55022/CISPR22 Class A ITE (Information Technology Equipment)

Barco Media Servers are products of class A ITE. ITE stands for Information Technology
Equipment. ITE is subdivided into two categories denoted class B ITE (products intended
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primarily for use in domestic environment) and class A ITE (all other ITE which satisfies
the class A ITE limits but not the class B ITE limits).

!
Caution

This is a class A product. In a domestic environment this product may cause
radio interference in which case the user may be required to take adequate
measures.

FCC compliance statement

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio fre-
quency energy and, if not installed and used in accordance with the instruction manual,
may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will
be required to correct the interference at his or her own expense.

1.3.3 Precautions

Warning

For your own protection, observe the following safety precautions when in-
stalling and operating your device.

• Before operating the units, please read this manual thoroughly and retain
it for future reference!

• Observe all warnings and instructions printed on the devices!

• Barco Media Servers do not require any maintenance work or servicing.
Servicing should never be carried out by unauthorized personnel!

• Never open the case of the unit without first disconnecting the power
supply cord!

• To prevent fire or electrical shock hazard, do not expose this unit to rain
or moisture!

• Do not place any warm or heat dissipating sources in the vicinity of the
unit.

• This product should be operated from an AC power source!

• Check that the voltage and frequency of your power supply match those
printed on the device label showing the rated electrical values!

• If you are not sure of the type of AC power available, consult your
dealer or local power company!
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• This product is equipped with a 3-wire grounding plug, i.e. a plug fea-
turing a third (grounding) pin. This plug will only fit into a grounding-
type power outlet. This is a safety feature. If you are unable to insert the
plug into your outlet, contact your electrician to replace the obsolete
outlet. Do not defeat the purpose of the grounding-type plug!

• This equipment must be grounded (earthed) via the 3-conductor AC
power cable supplied. (If the power cable supplied is not the correct
one, consult your dealer.)

• Do not allow anything to rest on the power cord. Do not position this
product in places where people will walk on the cord. To disconnect the
cord, pull it out by the plug. Never pull the cord itself.

• If an extension cord is used with this product, make sure that the total
of the ampere ratings on the products plugged into the extension cord
does not exceed the extension cord ampere rating.

• Never push objects of any kind into this product through cabinet slots
as they may touch dangerous voltage points or short out parts that could
result in a risk of fire or electrical shock.

• Never spill liquid of any kind on the product. Should any liquid or solid
object fall into the cabinet, unplug the set and have it checked by quali-
fied service personnel before resuming operations.

• Lightning—For extra protection of this video product during a lightning
storm, or when it is left unattended and unused for a long period of
time, unplug it from the wall outlet. This will prevent damage to the
unit due to lightning and AC power-line surges.

Power cords with NEMA 5-15 plugs

Figure 1.1. NEMA 5-15 plug

green or yellow + green earth (ground)

blue or white neutral

brown or black line (live)

• The cord set must be UL approved and CSA certified.

• The minimum specification for the flexible cord is No. 16 AWG, type
SJT, 16 A, 60°C, 4.5 m long max., 125 V, 3-conductor.
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• The cord set must have a rated current capacity of at least 11 A.

• The attachment plug must be an earth-grounding type with a NEMA
5-15P (15 A, 125 V) configuration.

General installation instructions

• Do not place this unit on an unstable cart, stand, or table. The unit may
fall, causing serious damage to it.

• Do not use this unit near water.

• Do not use any power cords other than the one supplied with your unit.
While appearing to be similar, other power cords have not been safety
tested at the factory and must not be used to power the unit. For a re-
placement power cord, contact your dealer.

• Slots and openings in the cabinet and the sides are provided for ventila-
tion; to ensure reliable operation of the unit and to protect it from over-
heating, these openings must not be blocked or covered. The openings
should never be blocked by placing the product on a bed, sofa, rug, or
other similar surface. This product should never be placed near or over
a radiator or heat register. This unit should not be placed in a built-in
installation or enclosure unless proper ventilation is provided.

• The maximum recommended ambient temperature for this equipment
is 40°C.

• When using the unit in a multi-unit rack assembly or closed assembly,
the ambient temperature inside the assembly may not exceed the max-
imum rated ambient temperature.

• When installed in a rack, the installation should be such that the amount
of air flow required for safe operation of the equipment is not comprom-
ised. The mounting of the equipment should be such that no hazardous
condition is achieved due to uneven mechanical loading.

1.3.4 Additional information

Servicing

Barco Media Servers do not require any servicing or regular maintenance work.

Cleaning

Unplug this product from the wall outlet before cleaning. Do not use liquid or aerosol
cleaners.
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Unpacking of devices

For unpacking, follow the instructions and advice indicated on the outside of the
packaging.

Repacking

Keep the original shipping carton and packing material; they will come in handy should
you ever have to ship your unit. For maximum protection, repack your equipment as
it was originally packed at the factory.

1.4 Environmental information: disposal

1.4.1 Disposal of the product (Waste Electrical and Electronic Equipment)

This symbol on the product indicates that, under the European Directive
2012/19/EU governing waste from electrical and electronic equipment, this product
must not be disposed of with other municipal waste. Please dispose of your waste
equipment by handing it over to a designated collection point for the recycling of waste
electrical and electronic equipment. To prevent possible harm to the environment or
human health from uncontrolled waste disposal, please separate these items from other
types of waste and recycle them responsibly to promote the sustainable reuse of mater-
ial resources.

For more information about recycling of this product, please contact your local city office
or your municipal waste disposal service. For details, please visit the Barco website at:
http://www.barco.com/en/AboutBarco/weee.

1.4.2 Disposal of batteries

This product contains batteries covered by the Directive which must be collected and
disposed of separately from municipal waste.

If the battery contains more than the specified values of lead (Pb), mercury
(Hg) or cadmium (Cd), these chemical symbols will appear below the crossed-out
wheeled bin symbol.

By participating in separate collection of batteries, you will help to ensure proper dis-
posal and to prevent potential negative effects on the environment and human health.
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1.5 RoHS compliance

1.5.1 中国大陆 RoHS (Chinese Mainland RoHS)
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有毒有害物质或元素

Hazardous substances or elements
零件项目(名称)
Component name

多溴二苯醚

PBDE
多溴联苯

PBB
�价铬
Cr6+

镉

Cd
汞

Hg
铅

Pb

OOOOOX
印制电路主要配件

Main printed circuit as-
sembly

OOOOOX
插入式印制电路配件

Plug-in printed circuit
assembly

OOOOOX
外接电(线)缆
External Cables

OOOOOX
內部线路

Internal wiring

OOOOOO
散热片(器)
Heatsinks

OOOOOX
电源供应器

Power supply unit

OOOOOX
风扇

Fan

OOOOOX
电池(组)
Batteries

OOOOOO
底架

Chassis

OOOOOO

螺帽,螺钉(栓),螺旋( 钉),
垫圈, 紧固件
Nuts, bolts, screws,
washers, fasteners

这个表被制备按照规定SJ/T 11364
This table is prepared in accordance with the provisions of SJ/T 11364.

O: 表示该有毒有害物质在该部件所有均质材料中的含量均在 SJ/T 11363 标准规定的限
量要求以下.
O: Indicates that this toxic or hazardous substance contained in all of the homogeneous
materials for this part is below the limit requirement in SJ/T11363.

X: 表示该有毒有害物质至少在该部件的某一均质材料中的含量超出 SJ/T 11363 标准规
定的限量要求.
X: Indicates that this toxic or hazardous substance contained in at least one of the ho-
mogeneous materials used for this part is above the limit requirement in SJ/T11363.

Table 1.1. 中国大陆 RoHS (Chinese Mainland RoHS)
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在中国大陆销售的相应电子信息产品（EIP）都必须遵照中国大陆《电子信息产品污染
控制标识要求》标准贴上环保使用期限（EFUP）标签。Barco产品所采用的EFUP标签
（请参阅实例，徽标内部的编号使用于制定产品）基于中国大陆的《电子信息产品环保
使用期限通则》标准。

All electronic information products (EIP) that are sold within Chinese Mainland must
comply with the “Electronic Information Products Pollution Control Labeling Standard”
of Chinese Mainland, marked with the Environmental Friendly Use Period (EFUP) logo.
The number inside the EFUP logo that Barco uses (see the figure) is based on the
“Standard of Electronic Information Products Environmental Friendly Use Period” of
Chinese Mainland.

Figure 1.2. EFUP logo

1.5.2 Turkey RoHS compliance

Türkiye Cumhuriyeti: AEEE Yönetmeliğine Uygundur.

[Republic of Turkey: In conformity with the WEEE Regulation]

1.6 Terms and definitions

3G A 3 Gbit/s serial digital 10-bit or 12-bit video inter-
face (SMPTE 424M and 425M).

Active DisplayPort-to-DVI Ad-
apter

A DisplayPort-to-DVI adapter that converts the
DisplayPort signal to DVI. A passive DisplayPort-
to-DVI Adapter carries the signal from a DisplayPort
port to a DVI port, without conversion. With a
passive adapter, the video card must perform the
conversion.

Genlock A module that allows synchronization to external
sources and delivers synchronized display output.

HD-SDI High-Definition Serial Digital Interface; an HD-SDI
signal (SMPTE 292M). Format examples include
720p, 1080i, and 1080p.
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Master Power Switch Power switch on the rear panel of a Barco Media
Server. The Master Power switch removes power
from the unit, without performing a shutdown.

Power Switch Power switch on the front panel of a Barco Media
Server. The Power switch performs a shutdown, then
removes power from the unit.

SD-SDI Standard-definition Serial Digital Interface; an SD-
SDI signal (SMPTE 292M). Format examples include
480i and 525i.

System Restore A process that can restore the applications and set-
tings on the C: drive to their original condition.
System Restore also restores the needed software li-
censes. A Full Restore can erase the data on the D:
drive.

Windows Image Operating system. This version of the Barco Media
Server is based on Microsoft® Windows® 8.1 EMB
Industry Pro and must be at least version 01.06.00.

X-Agora Refers to the GUI application that allows you to
create, run, and monitor a project. X-Agora software
suite refers to X-Agora, X-Agora Agent, X-Agora
Player, and X-Agora Server. See The X-Agora architec-
ture (p.48).
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Section 2: Installation

This chapter gives instructions on how to install and run both the hardware and software
of the Barco Media Server, powered by X-Agora.

2.1 Installation requirements

Warning

Let the Barco Media Server acclimate to the ambient temperature after
unpacking. Ensure that the humidity is within the specification. Neglecting
this may result in startup failure of the device.

2.1.1 Disconnect device

Where a disconnect device is not incorporated in the equipment, or where the plug on
the power supply cord is intended to serve as the disconnect device:

• for PERMANENTLY CONNECTED EQUIPMENT, a readily accessible
disconnect device shall be incorporated external to the equipment.

• for PLUGGABLE EQUIPMENT, the socket-outlet shall be installed near
the equipment and shall be easily accessible.

2.1.2 Barco Media Server Windows® image

This version of the Barco Media Server is based on Microsoft® Windows® 8.1 EMB In-
dustry Pro and must be at least version 01.06.00.

Verify that the Barco Media Server is loaded with the latest Windows image available
on the Barco website. Refer to Restore (p.35) for more information about upgrading the
Barco Media Server Windows image.

2.1.3 X-Agora GUI

The X-Agora GUI software must be at least Version 2.2.000.
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2.2 Initial inspection

2.2.1 General

Before shipment, the Barco Media Server was inspected and found to be free of mech-
anical and electrical defects. As soon as the Barco Media Server is unpacked, inspect it
for any damage that may have occurred in transit. Save all packing material until the
inspection is completed. If damage is found, file a claim with the carrier immediately.
Notify the Barco sales and service office as soon as possible.

2.2.2 Unpacking

At delivery the Barco Media Server is packed in a cardboard box. Place the box on a
stable (solid), flat, and insulated support during all the unpacking. Open the box from
the top. Remove the Barco Media Server from its antistatic bag. Check the box content.

After unpacking let the Barco Media Server acclimate to room temperature, which must
be higher than 0°C (32°F) and lower than 40°C (104°F). Neglecting this may result in
startup failure.

Save the original shipping box and packing material; these will be necessary if you ever
have to ship your Barco Media Server. For maximum protection, repack your Barco
Media Server as it was originally packed at the factory.

2.2.3 Box content

After unpacking the Barco Media Server, check if all of the following items were included:

Accessories includedProduct contains

4RU rack-mount chassis • Barco Media Server assembly
• USB keyboard
• USB mouse
• US Power Cord NEMA 5/15 (not included

with units shipped to China)1

• 3× passive DisplayPort-to-DVI adapters2

• 2× active DisplayPort-to-DVI adapters2

• USB System Restore drive3

• Safety manual

Table 2.1. Box content

Notes:

1. Barco does not provide power cords for all locations. It may be neces-
sary to install a power-cord cap for your location. See Replacing a power-
cord cap (p.69).
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2. The video output card can handle two DisplayPort-to-DVI conversions
on its own; for these conversions you may use the passive DisplayPort-
to-DVI adapters.

a. If you wish to connect to more than two DVI devices,
you must use the active DisplayPort-to-DVI adapters
for the any conversions beyond the first two.

b. To get all four outputs, connect the passive adapters
to ports 1 and 2, and connect the active adapters to
ports 3 and 4.

3. The USB System Restore drive contains the user guide and the recovery
software. To restore the system using the USB System Restore drive,
see Restore (p.35).

2.2.4 Mechanical check

Confirm that there are no broken parts and that the unit is free of dents or scratches. If
you find broken parts, dents, or scratches, notify your Barco sales representative as soon
as possible.

2.3 Rack-mount procedure
The Barco Media Server chassis is designed to be rack mounted. Please note the following
important points:

• The Barco Media Server is 4RU in height.

• The maximum ambient operating temperature is 40° C.

• Leave sufficient front and rear space to ensure that airflow through the
Barco Media Server is not restricted.

• Distribute the units evenly, when installing equipment in a rack, to
prevent hazardous conditions that may be created by uneven weight
distribution.

• Connect the Barco Media Server only to a properly rated supply circuit.

• Maintain reliable grounding (earthing) of rack-mounted equipment.

• Mount the Barco Media Server from the front rack ears, using four rack
screws (not supplied).

(Threads may be metric or otherwise, depending upon the rack type.)
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!
Caution

At a minimum, an XHD-400 Series server chassis weighs 13.6 kg (30 lbs.). To
avoid injury, we recommend that two people rack mount the chassis.

2.4 Connections
Make the following connections to the rear panel of the Barco Media Server.

1. Connect a monitor to the DVI port labelled “Desktop.”

(DVI cable not included.)

2. Connect keyboard and mouse to USB 2.0 ports.

3. Connect power cord.

2.5 Powering ON the Barco Media Server
Switch the master power switch on the rear panel to ON.

The Barco Media Server box turns on immediately.

Note

If the system is powered off any time after it has been initially powered on,
you can power on the system again using the power switch on the front
panel. If the Barco Media Server does not start, ensure that the master power
switch on the rear panel is ON.

Ensure that the Barco Media Server is connected to an appropriately-rated
power source.

Warning

This equipment is designed for connection to a branch circuit having a
maximum overload protection of 20 A.

2.6 Software startup
Barco Media Server boxes come pre-installed with Microsoft®Windows® Embedded
8.1 x64 and X-Agora™. When the box is powered on, Windows opens an empty desktop
with two icons in the left-hand corner of the taskbar.
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• Double-click the X-Agora icon either on the taskbar or on the Desktop)
to open X-Agora.

• Right-click the Windows icon on the taskbar to gain access to the
following items:

• Control Panel
• File Explorer
• Run
• Shut down or sign out
• Desktop

• Select (left-click) the Windows icon, and select the circled down-arrow
on the Start screen, to access all applications on the machine.

2.7 Licensing
Barco Media Server boxes come pre-installed with Microsoft® Windows® Embedded
8.1 x64 and X-Agora™.

Barco Media Server software is secured by the CodeMeter hardware and software licens-
ing solution from Wibu Systems. A local runtime application, CodeMeter Control Center
(also known as CodeMeter User Runtime) controls the licenses. An XHD-Series license
or an XDG-100 Designer license contains only the licenses needed to operate Barco
Media Server software. Barco Media Server software can be downloaded from the Barco
website. Go to http://www.barco.com/ → Products & Solutions → Image Processing →
Media Servers.

2.7.1 CodeMeter Control Center

The CodeMeter Control Center runtime application must run on each machine on which
Barco Media Server software is expected to run. CodeMeter Control Center is the local
management tool for hardware and software licenses, and it also plays a crucial part in
updating licenses remotely. CodeMeter Control Center is preinstalled on all Barco Media
Servers, and it is also part of the Barco Media Server software installer.

Note

If needed, CodeMeter Control Center (CodeMeter Runtime 5.21b or later)
can be downloaded from http://codemeter.com/us/service/down-
loads.htmlhttp://codemeter.com/us/service/downloads.html.
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2.7.2 Launching CodeMeter Control Center

Use the CodeMeter Control Center to check current licenses or request an update for
an existing license. Launch the CodeMeter Control Center with a single step.

1. Double-click the CodeMeter Icon in taskbar notification area to launch
the CodeMeter Control Center.

Figure 2.1. Launching CodeMeter Control Center

2.7.3 XHD-Series licensing

This section describes how to check current licenses and request an update for an existing
license issued by Barco for a Barco Media Server XHD-Series server.

Checking current licenses

1. Launch the CodeMeter Control Center.

2. Find the XHD-Series license listed in CodeMeter Control Center (See
Figure 2.2, “CodeMeter Control Center overview for XHD-series license.”.)

Figure 2.2. CodeMeter Control Center overview for XHD-series license.

3. Click on WebAdmin to see more details.
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This opens a webpage.

4. Navigate to the License pane under Content. (See Figure 2.3, “WebAdmin
License page for XHD-series licenses”.)

Figure 2.3. WebAdmin License page for XHD-series licenses

5. XHD-Series licenses must have the Product Codes shown in Figure 2.4,
“XHD-series product codes” to properly work with Barco Media Server
software.

Figure 2.4. XHD-series product codes

Requesting an update for an existing XHD-series license

1. Launch CodeMeter Control Center.

2. Find the XHD-Series License listed in CodeMeter Control Center (See
Figure 2.2, “CodeMeter Control Center overview for XHD-series license.”.)

3. Click License Update.

4. Click Next.
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5. Select Create License Request.

6. Select Extend Existing License.

7. Check Firm code 5000511 (Barco, Inc.) and click Next.

8. Send the resulting .WibuCmRac file to Barco.

2.7.4 XDG-100 Designer licensing

This section describes how to check a current license and request an update for an existing
XDG-100 license issued by Barco.

Minimum laptop requirements

The XDG-100 Designer may be run on a laptop computer, so long as that laptop meets
the following minimum requirements.

Video card: NVIDIA GeForce GTX850M 4GB DDR3

CPU: Intel® Core™ i7-4710HQ at 2.50 GHz

RAM: 8 GB DDR3

Screen: 15 in. screen, with 1600×900 resolution

Storage: 256 GB SSD

OS: Microsoft® Windows® 8.1

Checking current licenses

1. Launch the CodeMeter Control Center.

2. Insert the XDG-100 Designer USB drive in a USB port on your computer.

3. Find the XDG-100 license listed in CodeMeter Control Center (See
Figure 2.5, “CodeMeter Control Center overview for XDG-100 license.”.)
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Figure 2.5. CodeMeter Control Center overview for XDG-100 license.

4. Click on WebAdmin to see more details.

This opens a webpage.

5. Navigate to the License pane under Content. (See Figure 2.6, “WebAdmin
License page for XDG-100 licenses”.)

Figure 2.6. WebAdmin License page for XDG-100 licenses
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6. XDG-100 licenses must have the Product Codes shown in Figure 2.7,
“XDG-100 product codes” to properly work with Barco Media Server
software.

Figure 2.7. XDG-100 product codes

Requesting an update for an existing XDG-100 license

1. Launch CodeMeter Control Center.

2. Insert the XDG-100 Designer USB drive in a USB port on your computer.

3. Find the XDG-100 license listed in CodeMeter Control Center (See
Figure 2.5, “CodeMeter Control Center overview for XDG-100 license.”.)

4. Click License Update.

5. Click Next.

6. Select Create License Request.

7. Select Extend Existing License.

8. Check Firm code 102712 (Barco, Inc.) and click Next.

9. Send the resulting .WibuCmRac file to Barco.

2.8 Shutdown and restart
The Barco Media Server can be shut down and restarted from Windows or by means
of the hardware power switches on the front and rear panels of the Barco Media Server
box.

Note

X-Agora always opens with the most recently saved data. Remember always
to exit X-Agora before shutting down or restarting the Barco Media Server.
Upon exiting, X-Agora prompts you to save your work. If you do not save
your work in X-Agora before shutting down or restarting the Barco Media
Server, some of your work may be lost.
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2.8.1 Software shutdown

After saving your work and closing X-Agora, you can shut down the Barco Media
Server through Windows.

1. Right-click the Windows icon at the far-left end of the taskbar.

2. Hover the cursor over the Shut down or sign out option in the pop-up
menu.

3. Select Shut down or Restart.

Figure 2.8. Windows shutdown menu

2.8.2 Hardware shutdown

The Barco Media Server box can be powered down by means of the power switch, the
reset button, or the master power switch. Only the power switch performs a shutdown.

Hardware shutdown options

• Press the power switch on the front panel to shut down the Barco Media
Server.

• Press the reset button on the front panel to power off and power on the
Barco Media Server.

The box powers off, without a shutdown procedure, and powers on
again. Data may be lost.

• Press the master power switch on the rear panel to power-off the Barco
Media Server.

The box powers off without a shutdown procedure. Data may be lost.

2.9 Restore
Restore the applications, software licenses, and settings on the C: drive with a System
Restore, or both restore the applications, software licenses, and settings on the C: drive
and erase the data on the D: drive with a Full Restore.
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2.9.1 System Restore

Use the following steps to perform a System Restore.

1. Plug the USB Recovery drive into one of the external USB 3.0 ports on
the Barco Media Server.

The Barco USB Recovery drive is a USB 3.0 device; you may reduce
recovery time by using this drive in a USB 3.0 port.

2. Right-click the Windows icon at the lower left-hand corner of the
screen to restart.

As the system restarts, it displays the Barco logo screen.

3. Press and hold the F8 key to summon the Select Boot Device screen.

4. Select the USB Recovery drive (STT ST3U16SSPS (15000MB)).

Use the up and down arrow keys on your keyboard, or use your mouse
to make selections.

After the system restarts, the Restore application displays the Barco
Media Server Validation screen.

Figure 2.9. Barco Media Server Validation screen

5. Allow the System Restore menu to load.

The System Restore menu takes a few minutes to load. During this
time, a number of small windows appear and disappear. Wait until
you see a full-screen menu titled Barco Media System Restore Menu.
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Figure 2.10. Barco Media Server System Restore Menu

6. Select the System Restore option or Exit to cancel the operation.

If you select System Restore, the system displays the Confirmation
screen.

Note

Do not select Full System Restore, unless you intend to de-
lete all the data on the D: drive. See Full System Restore
(p.39).
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Figure 2.11. Confirmation screen

7. Select Confirm, and the Restore begins.

8. Allow the Restore to run.

The Restore process takes between 10 and 30 minutes. The system
displays status throughout the Restore.

Figure 2.12. Sample Status screen
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Once the Restore has reached this point (Applying the main volume),
the Barco Media Server automatically restarts.

9. Allow a few minutes for the Barco Media Server to reconfigure.

Figure 2.13. Completion screen

After the restoration is complete, you may remove the USB System Restore thumb drive.

2.9.2 Full System Restore

The procedure for a Full System Restore is nearly the same as the procedure for a System
Restore. This not only restores the application, software licenses, and settings on the
C: drive, but it erases any data on the D: drive, restoring the system to its original con-
dition.

1. Plug the USB Recovery drive into one of the external USB 3.0 ports on
the Barco Media Server.

The Barco USB Recovery drive is a USB 3.0 device; you may reduce
recovery time by using this drive in a USB 3.0 port.

2. Right-click the Windows icon at the lower left-hand corner of the
screen to restart.

As the system restarts, it displays the Barco logo screen.

3. Press and hold the F8 key to summon the Select Boot Device screen.

4. Select the USB Recovery drive (STT ST3U16SSPS (15000MB)).
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Use the up and down arrow keys on your keyboard, or use your mouse
to make selections.

After the system restarts, the Restore application displays the Barco
Media Server Validation screen.

5. Allow the System Restore menu to load.

The System Restore menu takes a few minutes to load. During this
time, a number of small windows appear and disappear. Wait until
you see a full-screen menu titled Barco Media System Restore Menu.

6. Select the Full System Restore option or Exit to cancel the operation.

If you select Full System Restore, the system displays the Confirmation
screen with the warning, "!!CLICKING CONFIRM WILL DELETE ALL
CONTENT AND DATA!!".

Note

A Full System Restore deletes all data from the D: drive. If
you wish to restore the applications, software licenses, and
settings on the C: drive without erasing the data on the D:
drive, use System Restore. See System Restore (p.36).

Figure 2.14. Barco Media Server Full System Restore Menu

7. Select Confirm, and the Restore begins.

8. Allow the Restore to run.

The Restore process takes between 10 and 30 minutes. The system
displays status throughout the Restore.
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Once the Restore has reached this point (Applying the main volume),
the Barco Media Server automatically restarts.

9. Allow a few minutes for the Barco Media Server to reconfigure.

2.9.3 Clearing CMOS

If the Barco Media Server hangs or fails to boot after any change to the BIOS settings,
press the clear CMOS button to clear the CMOS and reset the motherboard to its default
value.

The clear CMOS button is a small red button labelled CLR_CMOS, located near the
front end of the PCIe 3.0 x16_4 expansion slot. (In the XHD-402 and XHD-404 media
servers, this slot holds the video out card. In the XHD-200 and XHD-400 media servers,
this slot is empty.)

!
Caution

Do not press the CLR_CMOS button during a System Restore, because this
will interrupt the restore operation.
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Section 3: Hardware

X-Agora runs on various models of Barco Media Server. This chapter describes the
hardware configuration of the XHD-200 Series and the XHD-400 Series servers.

Although the XHD-200 Series and XHD-400/2/4 Series servers differ in height, they
have the same buttons, switches, LED indicators, and USB 3.0 ports on the front panel.

Figure 3.1. XHD-Series server—front panel

3.1 XHD-200 series

Figure 3.2. XHD-200 server—rear panel

• XHD–200 (2u chassis)

• Outputs – 2

• Inputs – 0
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3.2 XHD-400 series

Figure 3.3. XHD-400 server—rear panel

• XHD–400 (4u chassis)

• Outputs – 4

• Inputs – 0

Figure 3.4. XHD-402 server—rear panel

• XHD–402 (same 4u chassis as XHD–400)
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• Outputs – 4 DisplayPort 1.2a

• Inputs – 2 single-link DVI capture

Figure 3.5. XHD-404 server—rear panel

• XHD–404 (same 4u chassis as XHD–400)

• Outputs – 4 DisplayPort 1.2a

• Inputs – 4×3G SDI

• Genlock – synchronization module
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Section 4: Software

The X-Agora software suite is a unified software environment designed to facilitate
projection mapping project workflow from design to playback and operation.

4.1 Requirements

4.1.1 Hardware

X-Agora machines run Windows Embedded 8.1 x64.

These machines come pre-installed with X-Agora, including a license for the software.
To perform X-Agora updates, you must run the X-Agora wizard, which is explained in
this guide.

4.1.2 Distributed deployment

If your installation requires the use of multiple X-Agora machines (because of a high
number of required outputs or for performance reasons), it is important that all of the
machines run the same exact version of the software, to avoid communication problems
and feature discrepancies between components.

4.1.3 Network

X-Agora relies on the proper functioning of your network, and makes a few assumptions:

• TCP and UDP communication is open on the network. These protocols
are used for small file transfers, clock synchronization, and the commu-
nication of interactive signals.

• All X-Agora machines have the same Windows credentials. This ensures
that the use of Windows file sharing works for the transfer of media
files.

• All X-Agora machines automatically log on to a Windows session at
boot time. This ensures that all the necessary applications are running
when needed.

You may wish to isolate the X-Agora network from external inputs for security reasons.
Please keep in mind that X-Agora uses different network protocols for its proper func-
tioning, and that within the X-Agora network it is recommended to leave all communic-
ation open.
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4.2 The X-Agora architecture
The X-Agora system operates according to a client-server architecture to allow maximum
scalability. A typical X-Agora deployment comprises a Controller PC and multiple
Player PCs, connected together as the X-Agora network. The Controller PC runs the X-
Agora Server application that manages and coordinates the Player PC clients (all of
which run the X-Agora Player and X-Agora Agent applications). For larger venues, the
X-Agora architecture can be extended to support additional clients and servers according
to project needs.

The X-Agora software suite components include:

• X-Agora

• X-Agora Agent

• X-Agora Player

• X-Agora Server

4.2.1 X-Agora

X-Agora allows you to create a project, import media, assign outputs to player machines
and monitor the status of your event while it is running.

This application allows you to work with 2D projects, in which all playback takes place
on LED or LCD displays, or with 3D projects, in which you can also use projectors and
import your own 3D models.

4.2.2 X-Agora Agent

X-Agora Agent is an application that supports the X-Agora Player application. It is in-
stalled on every machine in the X-Agora network to facilitate the server's control of the
network and communication between the player and the server.

4.2.3 X-Agora Player

It is as simple as this: “The player plays your media.”

Everything programmed in X-Agora is made visible or audible by a player.

Note

The X-Agora Player is not capable of media playback on its own. It requires
the X-Agora Server and X-Agora Agent applications to coordinate its actions.

Hardware and software licenses protect each X-Agora Player with regard to managing
the number of outputs that can be connected to a physical machine and validating the
number of live input devices that can be used.
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4.2.4 X-Agora Server

X-Agora Server is a Windows service installed on the controller PC to coordinate all of
the X-Agora elements on the network. Every application in the X-Agora network operates
as a client of X-Agora Server, allowing you to remotely monitor and maintain your X-
Agora network from the controller PC.

The X-Agora Server—

• Coordinates all nodes on the X-Agora network.

• Acts as a centralized logger and message relay carrier between players.

• Hosts all media files.

• Synchronizes all players with updates to the media and virtual scene.

This documentation can be accessed from within X-Agora by pressing the F1 key. You
can also press F1 in each pane to display its documentation.

Figure 4.1. X-Agora F1 Help

4.3 Getting started—Install, Uninstall, and Update

4.3.1 X-Agora Wizard

1. Launch X-Agora Installer.exe.

2. Select Next.
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Figure 4.2. Launch the installer, and select Next

3. Select Accept to accept the license; then select Next.
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Figure 4.3. Accept the license, and select Next

4. Select either Install, Uninstall, or Update in the drop-down menu;
then select Next.

If the software is already installed, select Uninstall or Update in the
drop-down menu and select Next. If the software is not already present,
the Installation Wizard automatically chooses the Install option. You
can choose where to put the software and also where to put the project
files. By default, the Installation Wizard picks the disk partition with
the most free space as the target for project files.
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Figure 4.4. Start the Installation or Update

5. Select Next to start the Installation or Update.

You may have to confirm to some prompts for X-Agora requirements.
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Figure 4.5. X-Agora

6. Select Close to exit the Installation Wizard.

Note

Uninstalling the software removes all the files that were placed on the
computer at installation: binary files, some configuration files, and the demo
project. Extra files such as your own projects or additional configuration files
are not removed.

Note

Updating an installation is possible for upgrades and also downgrades, using
the same steps.

4.4 Network setup
Every machine in your setup can be a Player or the Master Player.

Also, as explained in Remote mode (p.132), it is possible to connect remotely to the Master
Player (e.g., with your laptop), so you can modify your project remotely.
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To set up a project on multiple machines, you need a Server machine and at least one
Player machine.

1. On a Server machine, open X-Agora Server.

The process opens in the background, and an icon appears in the noti-
fication area on the taskbar.

2. On a Player machine, open X-Agora Agent and follow the steps in
Configuring Agent (p.54).

Every machine in your setup can be a Player or the Master Player.

It is also possible to connect remotely to the Master Player (e.g., with your laptop), so
you can modify your project remotely.

4.5 Configuring Agent
X-Agora Agent is configured by default to connect to its local X-Agora Server service.
When changing the Master Player in your project, all the required instances of X-Agora
Agent point to the new Master Player. You can also change the default configuration
manually.

To change the default configuration manually—

1. Launch Agent as an administrator.

(Double-click on the Agent icon in the notification area.)

2. Select the Configuration tab.

3. Enter the X-Agora Player Executable path (if not entered already).

The default path is C:\X-Agora\xagora-projection\xframe-3d.exe.

4. Enter the Media Server Directory path (if not entered already).

The default path is C:\X-Agora\xagora-projection\.

5. Enter the Master Player type:

• For a local Master Player, select Manual, enter address
127.0.0.1 or 'localhost', use Port 5000, and select Con-
nect.

• For a remote Player, select the address of the server,
use Port 5000, and select Connect.

6. Select Save to save the settings parameters.

X-Agora asks you to restart.
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7. Restart X-Agora Agent.

Note

If remote share has not been configured prior to X-Agora installation, enter
User and Password to access the remote machine and select Connect To
Remote Share.

4.6 Launching X-Agora

1. Launch X-Agora Server by selecting the X-Agora Server shortcut from
the Desktop or from the Start Menu.

2. Launch X-Agora by selecting the X-Agora shortcut from the Desktop
or from the Start Menu.

Note

X-Agora Server must be running for X-Agora to launch.

Note

The Windows service xagoraServer MUST be running for X-Agora to launch.
It is enabled by default and launched automatically at Windows boot time.
Also make sure that you have the proper license for running the software.

4.7 X-Agora interface
Figure 4.6, “X-Agora start screen” shows the X-Agora start screen. From this screen, you
can open a new project or an existing project by clicking either New Project… or the
name of an existing project, for example xagoraShape.
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Figure 4.6. X-Agora start screen

4.7.1 Parts of the interface

X-Agora opens the project, defaulting to the workflow layout that was in use the last
time the project was open. In the case of a new project, X-Agora opens the Study layout.
Figure 4.7, “X-Agora Programming workflow layout” shows an existing project open in the
Proramming workflow layout.

Figure 4.7. X-Agora Programming workflow layout
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The interface comprises a menu bar, divided into left-hand and right-hand halves, and
a workspace containing various panes.

Menu bar

The left-hand side of the menu bar has five menus: File, Edit, Window, Tools, and Help.
From the File menu you can select…

New… to open a new project

Open to open an existing project

Save to save a project

Save As… to save a project with a different name

Import… to import a file injto a project

Export… to export a project as a 3D model (*.fbx)

Connect to a Remote Server to connect to a remote server

Close to close a project

Exit to exit X-Agora

From the Edit menu you can either undo or redo changes to a project.

From the Window menu you may choose which panes to display in the workspace. See
Workspace (p.58) for a brief description of the Window menu panes.

From the Tools menu you may open any of the listed tools.

Content Production

Projection Study Wizard

X-Agora Media Encoder

Export Projectors Textures

Logs

From the Help menu you may select About to open the X-Agora splash screen, which
displays the copyright and the software release number. You can also select Help (or
press the F1 key) to open the X-Agora Designer User Guide.

Workflow layouts

The right-hand side of the menu bar allows you to choose from among the five workflow
layouts in X-Agora.

Study: Study, also called Projection Study, is mostly used in the initial phases of a pro-
duction. It is the layout best suited for creating your 3D scene and arranging your dis-
plays. You can create multiple display configurations, and produce a study document
to detail and evaluate each configuration. If there is no need to produce such documents,
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you should still use the Projection Study layout to create your scene and displays, because
this layout has features that may help people working at a more technical level: technical
directors, architects, and integrators.

Programming: The Programming tool allows you to build content Timelines. X-Agora
allows you to create as many Timelines as you want in each X-Agora project. Because
it was designed for large-scale installations, X-Agora also allows you to playback multiple
Timelines simultaneously. Often, in large-scale installations, there are multiple screen
spaces, and often it is easier to compartmentalize content for each screen space on a
dedicated Timeline.

Outputs: Use the Outputs layout to connect individual projectors and displays to the
physical outputs of the graphic cards on your Player computers. The Outputs layout
also allows you to tweak settings, such as the position of windows and the amount of
antialiasing.

Calibration: Use the Calibration layout to calibrate individual projectors when on site.
X-Agora features four projection calibration tools, some of which can be used in conjunc-
tion with each other.

Playback: The Playback layout is meant to play your show. It features a simplified in-
terface for streamlined playback, in which Timelines are not editable to avoid accidental
changes. It also features the control room view of player outputs, allowing you to
monitor the output and performance of your player machines during operation.

Workspace

The workspace is divided into several panes. You may show or hide any of the panes
by selecting or deselecting them in the Window menu. The central pane is the Viewport.
The Viewport pane is where most manipulation and visualization of your 3D scene oc-
curs.

Displays pane: The Displays pane allows you to adjust the properties of projectors and
screens to the real-world constraints of your project.

Media pane: X-Agora supports various types of video, image, sound and real-time
media formats (such as particle systems and live-feeds). See Supported 3D, audio, image,
and video formats (p.192). The Media pane allows you to import, preview, and refresh
media.

Timelines: The Timelines pane contains all the Timelines and Timeline Groups in a
given scene. Do not confuse the Timelines pane with the Timeline pane, in which you
assemble media assets to compose a show or multimedia installation.

Actions pane: Actions give you real-time tools to go beyond basic video and sound
playback. They make it possible to add real-time visual effects to your Timelines, control
external systems such as Art-Net lighting fixtures, and move 3D objects in the scene.

3D objects pane: The 3D objects pane provides a list of all the 3D objects in a scene. It
also allows you to select them individually in order to highlight them in the Viewport
and expose their parameters in the Properties pane.
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Timeline pane: The Timeline pane displays the layered content of one timeline. Do not
confuse the Timeline pane with the Timelines pane, which contains all the Timelines
and Timeline Groups in a given scene. Use the Timeline pane to compose the show or
multimedia installation by assembling media assets in time. Create as many Timelines
as you want, and add video, image, sound, or real-time graphics in layers.

Properties pane: The Properties pane gives access to all user-editable elements. To access
the properties of any user-interface element, click on the element to open its Properties
pane.

Inputs: The Inputs pane allows you to create open sound control (OSC) and tangible
user interface object (TUIO) inputs that can then be used to control real-time media
elements in your project.

Viewport: The Viewport pane provides up to four distinct views of the 3D scene in order
to facilitate viewing and moving 3D objects and displays. Click on the Views Template
button, in the top right-hand corner of the Viewport pane, to change the number and
layout of views.

Settings pane: The Projection study section of the Settings menu provides access to key
features of the Projection Study Tool.

4.7.2 The X-Agora Designer User Guide

The X-Agora Designer User Guide documents the panes, tools, and workflow layouts in
X-Agora. You may access this documentation from within X-Agora by selecting the
Help menu from the left-hand side of the menu bar and selecting Help from the Help
menu. You may also access this documentation by pressing the F1 key. With your
cursor in any pane, you can press the F1 key to display the documentation for that pane.
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Appendix A: Specifications
This appendix contains specifications for Barco Media Servers and specifications and
pinouts for standard connectors.

A.1 Barco Media Server specifications

XHD-400 SeriesXHD-200 SeriesSpecification

4× DP 1.21× DP 1.2, 1× DVI-DChannel outputs

1× DVI, 1× DP 1.2–Designer outputs

Max. 1× 4K at 60 fps, 4× HD at
60 fps

Max. 2× HD at 60 fpsOutput resolution

Max. 2× 4K, 8× HDMax. 4× HDVideo layers

Mini JackMini JackSMPTE input

• XHD-400: none
• XHD-402: 2× Dual-link
DVI-D

• XHD-404: 4× 3G SDI

–Capture cards

SoftwareSoftwareEDID management

Balanced Audio XLR Connect-
ors

Balanced Audio XLR Connect-
ors

Audio output

8× USB 3.0, 4× USB 2.04× USB 3.0, 2× USB 2.0USB

100 V AC, 220 V AC100 V AC, 220 V ACInput voltage

2× Gigabit Ethernet1× Gigabit EthernetNetworking

512G SSD256G SSDStorage

• Width: 48 cm (19.0 in)
• Length: 42 cm (16.6 in)
• Height: 18 cm (7 in)

• Width: 48 cm (19.0 in)
• Length: 28 cm (11 in)
• Height: 9 cm (3.5 in)

Dimensions

13.6 kg (30 lbs.)6.4 kg (14 lbs.)Weight

14.9 kg (33 lbs.)7.3 kg (16 lbs.)Shipping weight

Full one-year parts and labor
standard, extended warranty
and support available.

Full one-year parts and labor
standard, extended warranty
and support available.

Warranty

Table A.1. Barco Media Server specifications
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A.2 Standard connection specifications

Barco Pn: 6060032062

Appendix A: SpecificationsBarco Media Server XHD-Series User Guide



DescriptionSpecification

Main (Display-
Port) and Exten-

• Display Connectors: DVI-I DL and DP 1.2
• Maximum Simultaneous Displays: 2 direct, 4 DP 1.2

Multi-Streamded (DVI)
Desktop • Resolution:

• 3,840×2,160 at 60 Hz Max DP 1.2 Res-
olution

• 2,560×1,600 at 60 Hz Max DVI-I DL
Resolution

• 1,920×1,200 at 60 Hz Max DVI-I SL
Resolution

• 2,048×1,536 at 85 Hz Max VGA Resol-
ution

• Memory Bandwidth: 29.0 GB/s
• Memory Interface: 128-bit
• GPU Memory: 2 GB DDR3
• Maximum Power Consumption: 45 W

Video Outputs
(DisplayPort)

• Four Standard DisplayPort outputs
• DisplayPort 1.2a support, including Adaptive-Sync

and HBR2
• Resolution:

• 4,096×2,160 Maximum DisplayPort
1.2a resolution

• 2,560×1,600 Maximum DisplayPort
1.1 resolution

• PCIe® 3.0 compliant, ×16 bus interface
• 8-GB GDDR5 memory
• 256-bit memory interface
• Up to 160 GB/s bandwidth
• Less than 150-W maximum power consumption

Genlock • Synchronization to external sources
• Clock-accurate synchronization
• BNC connector for receiving and synchronizing video

input source, including:

• PAL & NTSC SD video black burst
• HDTV tri-level sync
• TTL
• Sync signals on SDI
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DescriptionSpecification

• DVI-I (DL) connector

• Input channels: 2
• Output channels: 0

• Supports HDMI, DVI, and composite video capture
• PCIe ×4 half size plug-in card (110 mm × 170 mm)

DVI video cap-
ture

• SD/HD/3G SDI on BNC connector

• Input channels: 4
• Output channels: 0

• 6G Ready (via future firmware upgrade)
• PCI Express: 4-lane PCIe 2.0

SD/HD/3G SDI
video capture

Table A.2. Standard connection specifications

A.3 Standard connector pinouts

A.3.1 DisplayPort connector pinouts

Figure A.1, “DisplayPort connector” illustrates the DisplayPort connector.

Figure A.1. DisplayPort connector

Table A.3, “DisplayPort connector pins” lists the DisplayPort connector pinouts.
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SignalPinSignalPin

GND11ML_Lane 0 (p)1

ML-Lane 3 (n)12GND2

CONFIG1 (connected to Ground)13ML_Lane 0 (n)3

CONFIG2 (connected to Ground)14ML-Lane 1 (p)4

AUX CH (p)15GND5

GND16ML_Lane 1 (n)6

AUX CH (n)17ML-Lane 2 (p)7

Hot Plug Detect18GND8

Return (return for power)19ML_Lane 2 (n)9

DP_PWR Power for connector (3.3
V, 500 mA)

20ML_Lane 3 (p)10

Table A.3. DisplayPort connector pins

A.3.2 DVI connector pinouts

Figure A.2, “DVI connector” illustrates the DVI connector.

Figure A.2. DVI connector

Table A.4, “DVI connector pins” and Table A.5, “MicroCross pins” list the DVI connector
pinouts. Please note:

• TMDS = Transition Minimized Differential Signal

• DDC = Display Data Channel
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SignalPinSignalPin

TMDS Data 3+13TMDS Data 2–1

+5V Power14TMDS Data 2+2

GND (for +5V)15TMDS Data 2/4 Shield3

Hot Plug Detect16TMDS Data 4–4

TMDS Data 0–17TMDS Data 4+5

TMDS Data 0+18DDC Clock6

TMDS Data 0/5 Shield19DDC Data7

TMDS Data 5–20Analog Vertical Sync8

TMDS Data 5+21TMDS Data 1–9

TMDS Clock Shield22TMDS Data 1+10

TMDS Clock +23TMDS Data 1/3 Shield11

TMDS Clock –24TMDS Data 3–12

Table A.4. DVI connector pins

SignalPinSignalPin

Analog Horizontal SyncC4Analog Red VideoC1

Analog Common Ground ReturnC5Analog Green VideoC2

––Analog Blue VideoC3

Table A.5. MicroCross pins

A.3.3 Ethernet connector pinouts

Figure A.3, “Ethernet connector” illustrates the Ethernet connector.

Figure A.3. Ethernet connector

Table A.6, “Ethernet connector pins” lists Ethernet connector pinouts.
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1000 Base-T – RJ45 port de-
scription

10/100 Base-T – RJ45 port
description

ColorPairPin

TX0+TXD+white/green31

TX0–TXD–green32

RX0+RXD+white/or-
ange

23

TX1+–blue14

TX1––white/blue15

RX0–RXD–orange26

RX1+–white/brown47

RX1––brown48

Table A.6. Ethernet connector pins
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Appendix B: Replacing a power-cord cap
The Barco Media Server ships with an IEC power cord. Different locations (even within
the same country) may require a different power cord cap to connect the server to a
power outlet. Because of the variety of power cord caps used worldwide, Barco cannot
make specific recommendations for the power cord cap. Contact a local authority for
the type of power cord cap needed. When installing the power cord cap, note that the
cores in the mains lead are colored according to the following code:

• green and yellow = earth

• blue = neutral

• brown = live

B.1 Installing a Line Cord Cap – U.K. Only
In the United Kingdom, core colours in the mains lead of this equipment may not cor-
respond with the coloured markings identifying the terminals in the fixture’s plug. In
that case, install a line cord cap according to the following code:

• Connect the green and yellow core to the plug terminal marked with
the letter “E,” or by the earth symbol or coloured green, or green and
yellow.

• Connect the blue core to the terminal marked with the letter “N” or
coloured black.

• Connect the brown core to the terminal marked with the letter “L” or
coloured red.

Warning

Class 1 equipment – This equipment must be earthed.

B.2 Vatic Fitter Heads Information – Danmark
Advarsel: Beskyttelse mod elektrisk chock.

Vigtigt!

Lederne med gul/groen isolation maa kun tilsluttes en klemme maerket eller .
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Appendix C: AMD FirePro™ Control Center

C.1 Using Dedicated Fullscreen
Using Dedicated Fullscreen assures optimal video playback by taking full control of
the GPU and bypassing desktop composition similar to what they do in video games.
However, to use that mode, all outputs must be set in an Eyefinity Group. This section
explains how to setup an Eyefinity Group using the AMD FirePro Control Center and
how to manage the Eyefinity Group inside the X-Agora.

C.2 Setting up an Eyefinity Group

1. Right-click on Desktop and select AMD FirePro Control Center.

2. Expand AMD Eyefinity Multi-Display and click on the Create Eyefin-
ity Display group.
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Figure C.1. "Create Eyefinity Display Group"

3. Click on Use a new arrangement.
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Figure C.2. Use a new arrangement

4. Select the screen from which you want to create the Eyefinity group
and click on Next.

The other screens will be disabled.
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Figure C.3. Create the Eyefinity group

5. Select the layout type—for now, X-Agora supports only horizontal
layouts (2x1, 3x1, 4x1, etc.)—and click on Next.
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Figure C.4. Select a group layout
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Figure C.5. Display group complete

6. Click on Next twice.

The Eyefinity group should now span across multiple screens, as shown
in Figure C.6, “Eyefinity group spanning multiple screens”.

Figure C.6. Eyefinity group spanning multiple screens
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7. If the screens are not in the proper order, click on Arrange Eyefinity
Display Group and follow the screen indications to set up the correct
screen order.

Figure C.7. "Arrange Eyefinity Display Group"

C.3 Disable Eyefinity Group
To disable the Eyefinity Group, click on Disable Eyefinity Group in the AMD Eyefinity
Multi-Display menu.
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Figure C.8. "Disable Eyefinity Display Group"

C.4 Manage Eyefinity Group in Designer
In X-Agora, an Eyefinity Group is considered as one display so using the Identify
Monitors button shows only one large number for the group. The displays that are part
of the Eyefinity Group, however, are also identified individually with smaller numbers
from 1 to 6, depending of the number of displays in the group.
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Figure C.9. Two screens in one Eyefinity group

If the X-Agora Player is in Dedicated Fullscreen, the Eyefinity group is also represented
by a rectangle that spans across the correct number of displays in the group. In the fol-
lowing screenshot, the group spans across two outputs:

Figure C.10. Eyefinity group spanning two outputs
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Appendix D: EDID management
Extended display identification data (EDID) is managed through either the AMD
FirePro™ Control Center or the NVIDIA Control Panel.

D.1 Removing an emulated EDID through the AMD FirePro™
Control Center

1. Right-click anywhere on the desktop to summon the desktop menu.

2. Click on AMD FirePro Control Center.

Figure D.1. Select AMD FirePro Control Center

3. Select AMD FirePro in the navigation pane, and click EDID Emulation.

4. Select any emulated display connection.

An EDID that is being read from a display cannot be deleted; only
emulated EDIDs can be deleted.
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Figure D.2. AMD FirePro™ Control Center display connections

The four icons at the right-hand side of the selected connection allow
you to…

a. View the selected EDID in HEX format.
b. Save the selected EDID to a file.
c. Add or modify emulation properties.
d. Remove the selected EDID or branch emulation.

5. Click on the Minus icon to remove the selected EDID.

The text for the selected connection changes from “DisplayPort (Emu-
lated:…)” to “DisplayPort (Connected:…).”

D.2 Removing an emulated EDID through the NVIDIA Control
Panel

1. Right-click anywhere on the desktop to summon the desktop menu.

2. Click on NVIDIA Control Panel.
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Figure D.3. Select NVIDIA Control Panel

3. Select Workstation and View system topology from the Select a Task
pane of the NVIDIA Control Panel.

Figure D.4. NVIDIA Control Panel

Figure D.4, “NVIDIA Control Panel” shows that the DVI port of the
Quadro K620 is not connected, but the DisplayPort port is connected
to an ASUS monitor.

4. Click, under Settings, on the EDID you wish to manage.
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Figure D.5. NVIDIA Manage EDID window

The NVIDIA Manage EDID screen has three tabs.

a. Export allows you to create an EDID file based on the
current display.

b. Load allows you to load an EDID file to use as an
emulated EDID.

c. Unload allows you to remove an emulated EDID file
from a connection.

5. Select the Unload tab on the Manage EDID window.

6. Select the emulated EDID that you wish to remove.

Only emulated EDIDs may be selected and removed. If the connector
is reading an EDID from an active display, the connector is grayed out
and is not selectable.

7. Click on the Unload EDID button.
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Appendix E: Input check
The Barco Media Server has two applications that allow you to check whether or not
the video capture card is receiving input. The dREC application checks the SDI input
on the video capture card in the Barco Media Server XHD-404, and the Vision window
application checks the DVI input on the video capture card in the Barco Media Server
XHD-402.

E.1 DVI video input check
Use the Vision window application check the DVI input on the Datapath VisionAV-HD
video capture card in the Barco Media Server XHD-402.

1. Click the Windows icon at the lower left-hand corner of the screen
to access the Windows Apps screen.

2. Select the Vision window icon to open the New Vision Window.

3. Select the input (1 or 2) that you want to check from the Input drop-
down list.

4. Click OK.

The Vision Window checks the selected input. If the input is present, Vision Window
shows the input. (See Figure E.1, “Vision Window output”.) If no input is detected, Vision
Window displays the message, "No input."
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Figure E.1. Vision Window output

E.2 SDI video input check
Use the dREC application check the SDI input on the Delta-3G-elp 40-bb video capture
card in the Barco Media Server XHD-404.

1. Click the Windows icon at the lower left-hand corner of the screen
to access the Windows Apps screen.

2. Select the dREC icon to open dREC.

3. dREC displays the Record module.

• The Device Control panel displays the video capture
card parameters.

• The Card field identifies the card.
• The Channel field allows you to select

the video input channel (RX0 – RX3).
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• The Video Preview panel shows the input, if there is
any.

If there is no input signal, the Video Preview panel
displays the message, "NO SIGNAL."

Figure E.2. dREC Record module, showing "NO SIGNAL"
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Appendix F: Trouble shooting
Use Table F.1, “Trouble-shooting matrix” to trouble-shoot problems with the Barco
Media Server.

!
Caution

When handling power connections, remember to always follow safety pro-
cedures.

• Power down the Barco Media Server.

Switch off the power switch on the front panel and the
master power switch on the rear panel.

• Disconnect the power cord from the Barco Media Server.

• Remove all cables from the Barco Media Server.

• Make sure that your hands are free of dirt, grease, or foreign
substances that may damage the PCIe card or any com-
ponents that you may touch inside the server.

• Make sure you are "grounded."

Wear an anti-static wrist strap, also known as a ground
bracelet, or make sure that you touch a metal object that
is touching the ground to discharge any static electricity you
may have accumulated.
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RemedyPossible causeProblem

Make sure that the Master Power
switch on the rear panel is ON.

The Master Power switch is not
ON.

Media server
does not start

Make sure power supply is connec-
ted to a valid power source.

The power supply is not connec-
ted to a valid power source.

Check motherboard for any power
indication or errors.

Make sure that the EATX12V con-
nector is firmly seated.

EATX12V connector is loose or
disconnected from the mother-
board. When handling power connec-

tions, remember to always follow
safety procedures. See Caution.

If EATX12V is not connected, the
system may repeatedly start and
stop, start and stop.

Be sure to use supplied active and
passive adapters in proper order.

The DisplayPort-to-DVI adapter
may be incorrect.

No video output

See the notes to Table 2.1 in the
Box content (p.26) section of this
user guide.

Make sure cable is seated correctly
and the thumbscrews are tight.

The video cable may not be prop-
erly connected.

Enable the display in the Windows
screen setting.

The display has not been enabled
by Windows.

Remove the previously used EDID
and verify that you can see the

The EDID does not match the at-
tached display.

Windows desktop. (See EDID
management (p.81).)

Operating ambient temperature
must be higher than 0°C (32°F)

The operating temperature is too
high.

Images unstable
or showing bad
performance

and lower than 40°C (104°F).
Leave sufficient front and rear
clearance to ensure that airflow
through the chassis is not restric-
ted.

Be sure to encode content with X-
Agora Media Encoder.

The content is not properly en-
coded or has too many layers.

Content is not properly encoded,
or it has too many layers.
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RemedyPossible causeProblem

Make sure that the cable is seated
correctly and that the thumb-
screws are tight.

The connections may be incorrect.

Bad output on a
specific channel

Be sure not to exceed maximum
cable length.

The suggested cable length has
been exceeded.

Be sure to use the supplied con-
verters. (See Note #2 to Table 2.1,
“Box content”.) Swap the converter
for a converter with a known good
output.

The converters are unsupported.

Make sure that the cable is seated
correctly and that the thumb-
screws are tight.
Swap the cable for a known good
cable.

A connection or cable is bad.

Bad input on a
specific channel

Be sure not to exceed maximum
cable length.

The suggested cable length has
been exceeded.

Be sure to use the supplied con-
verters. (See Note #2 to Table 2.1,
“Box content”.) Swap the converter
for a converter with a known good
output.

The converters are unsupported.

• Be sure to use specified video
input formats. See the Supported
3D, audio, image, and video formats
(p.192) section of this user guide.
• To check the DVI inputs, use the
Vision window application in-
stalled on the server. See the DVI
video input check (p.85) section of
this user guide.
• To check the SDI inputs, use the
dREC application installed on the
server. See the SDI video input
check (p.86) section of this user
guide.

The input format is unsupported.
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RemedyPossible causeProblem

Check all of the Ethernet cables
and verify that they are plugged
in.
If you are using a network switch,
verify that is ON and is operating
properly.

This is a possible cable or network
switch issue.

Devices do not
communicate
through the net-
work.

Check to see if the IP address is
within your LAN range.

The IP address is incorrect; the IP
address is not within your LAN
range.

Check if the BMS network address
is already in use by another device
on the local network.

The IP address is incorrect; there
is a conflict between network ad-
dresses.

Disable the DHCP option and
enter a static network address
compatible with the PC running
the Event Master control software
(range, subnet mask, etc.).

This configuration does not have
a DHCP server.

The dynamic
configuration
(DHCP) does
not work, when
connecting a de-
signer laptop to
the server.

Make sure that the cables from the
front-panel switches are plugged
in on the motherboard.

The internal cables may be discon-
nected.

The unit does
not respond to
any front panel
switches.

Try a different USB device in the
port.

The USB device may be faulty.

The front-panel
USB ports do
not work.

Make sure that the cable from the
front-panel USB port is firmly
seated in the USB3_78 connector
on the motherboard.

The internal cable may be discon-
nected.

Make sure that the USB flash drive
is formatted to use the FAT32 file
system. If you cannot access the
USB flash drive from another PC,
then you may have a faulty USB
flash drive.

The USB drive may be bad or
formatted incorrectly.

Cannot read
from or write to
the USB drive.

Restart System Restore.
Power may have been lost during
System Restore.

Unable to per-
form a System
Restore

There is no immediate remedy; the
data is lost.
See the Restore (p.35) section of
this user guide.

A Full System Restore, rather than
a System Restore, was performed.

Data on the D:
drive is lost after
a System Re-
store.

Table F.1. Trouble-shooting matrix
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Appendix G: Window menu panes
The X-Agora interface offers several panes for viewing aspects of your project. You can
access these panes by using the Window menu on the menu bar at the top of the screen.
A checkmark next to an item in the Window drop-down menu indicates that the pane
for that item is active.

Figure G.1. Window tab

G.1 Displays pane
The Displays pane allows you to adjust the properties of projectors and screens to the
real-world constraints of your project.
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Figure G.2. Displays groups

1. Open the Displays pane and select the projector or screens the position
or parameters of which you wish to modify. (See Figure G.2, “Displays
groups”.)

Selecting a display (either in the Displays pane or in a Viewport) causes
the Properties panel to show the parameters of the selected display.

2. Edit the parameters of the display, such as its x, y, and z coordinates,
lens shift and throw ratio (for projectors), or resolution.

G.1.1 Display groups

The displays created to simulate real-world projector and screen setups appear as Pro-
jector Groups or Screen Groups in the Displays pane. Groups can be used to organize
your displays for ease-of-use.
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Figure G.3. New group

G.1.2 Add display

To add a display, you can use the menu shown in Figure G.3, “New group”. If you want
to add a display to an existing display group, use the + icon of that group. See Figure G.4,
“Add display to an existing group.”.

Figure G.4. Add display to an existing group.
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G.2 Media pane

G.2.1 Media type

X-Agora supports various types of video, image, sound and real-time media formats
(such as particle systems and live-feeds). See Supported 3D, audio, image, and video formats
(p.192).

Figure G.5. Media pane

G.2.2 Importing and refreshing media

To add media files, simply drag and drop media files from Windows Explorer onto a
Timeline or onto the Media Tab itself. This copies them to the X-Agora scene folder.

Note

The X-Agora media folder is located at <X-Agora Installation Folder>/xframe-
scenes/<scene name>/medias. Media assets are placed in their respective
subfolders (depending on their type).

To split high-resolution video files into the appropriate number of cropped sections
(according to the number of projectors defined in your projection study), use the X-
Agora Media Encoder (p.127).

G.2.3 Previewing media

To preview a media file, double-click on it, and a preview appears in the Properties
pane on the right.
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Figure G.6. Media preview

G.3 Timelines pane
The Timelines pane contains all the Timelines and Timeline Groups in a given scene.

Note

Do not confuse the Timelines pane with the Timeline pane, in which you as-
semble media assets to compose a show or multimedia installation.

Figure G.7. Timelines pane
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All Timelines are part of a Timeline Group. Each X-Agora project is created with at least
one Timeline Group by default.

To open a Timeline: Expand the Group by clicking the arrow next to it in the Timelines
tab in the bottom left-hand corner, and double-click a Timeline.

To create a new Timeline Group: Click the + symbol in the top right corner of the
Timelines pane.

To create a new Timeline within a Timeline Group: Click the + symbol directly to the
right of the Timeline Group.

The top bar in the Timelines tab allows you to show currently playing Timelines, to
stop all Timelines, or to search for a specific Timeline. To duplicate a Timeline, click on
it, then click the Duplicate Timeline icon at the top of the pane.

Expanding a Timeline (clicking the arrow to the left of the Timeline) causes a list of
TimeCues for that Timeline to appear. Clicking once on a TimeCue takes you to that
TimeCue in the Timeline pane. Double-clicking on a TimeCue starts playing that Timeline
from the TimeCue.

G.4 Actions pane
Actions give you real-time tools to go beyond basic video and sound playback. They
make it possible to add real-time visual effects to your Timelines, control external systems
such as Art-Net lighting fixtures, and move 3D objects in the scene.

G.4.1 Lighting

DescriptionAction

Transmits Art-Net values to a specific IP, Port, DMX universe and
channel(s).

Art-Net

Table G.1. Lighting

G.4.2 Particles

Particle system actions are presets with adjustable parameters.

G.4.3 Post-Processing

Post-processing actions are applied on the 2D image rendered in the Viewport (as op-
posed to individual objects or media assets).
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DescriptionAction

Applies ambient occlusion on the image.Ambient Occlu-
sion

Modifies saturation, min and max (black and white) levels, gamma,
hue offset, and brightness.

Color Correction

Fades in from plain black to the scene.Fade In

Fades out from the scene to black.Fade Out

Allows for manual fade control of the scene.Manual Fade

Defines a revealer object that, when in front of a defined revealed
object, reveals it.

Reveal

Provides tandard shader-based video effects.Video Filter Led
Simulator Glass
Ripples

Table G.2. Post-Processing

G.4.4 Sound

DescriptionAction

Plays a specific sound on an event.Play sound from
folder on event

Plays a specific sound on an event.Play sound on
event

Mixes a sound from different channels.Submix sound

Table G.3. Sound
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G.4.5 Timeline

DescriptionAction

Sends the playhead to the specified TimeCue.
The TimeCue can be either inside the same Timeline or in a seperate
Timeline.

Go to Cue

Pauses the playhead.
All free-running assets continue playing.

Pause Timeline

Plays a specific Timeline group.Play Timeline

Preloads all media assets to avoid lag when starting a Timeline.Preload
Timeline

Sends the playhead to the specified time (in the same Timeline).Seek time

Starts a specific Timeline upon an event trigger.Start Timeline
on event

Stops the Timeline on which the Action is placed.Stop Timeline

Selects the name of the Timeline to be stopped from the drop-down
list in this Action's properties.

Stop Timeline
by name

Stops a specific Timeline upon an event trigger.Stop Timeline
on event

Table G.4. Timeline

G.4.6 Transformations

DescriptionAction

Moves an object in the 3D space over time.Move node

Positions a node on a plane, according to normalized x and y coordin-
ates.

Position node on
plane

Rotates a node in three dimensions, given a rotation axis and an angle.Rotate node

Scales an Object in 3D Space over time.Scale node

Adjusts the UV of an object.UV adjust

Adjust UVs to apply a media on part of an object, or vice-versa.UV crop

Table G.5. Transformations
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G.4.7 Visibility

DescriptionAction

Hides a specified 3D object from the 3D scene for the duration of the
action.

Hide object

Shows a specified 3D object from the 3D scene for the duration of the
action.

Show object

Table G.6. Visibility

G.5 3D objects pane
The 3D Objects pane provides a list of all the 3D objects in your scene. It also allows
you to select them individually in order to highlight them in the Viewport and expose
their parameters in the Properties pane. You can use the Properties pane to resize and
reposition 3D objects. See 3D objects pane (p.145).

Figure G.8. 3D Object Properties pane

G.6 Timeline pane
The Timeline is where you compose the show or multimedia installation by assembling
media assets in time. Create as many Timelines as you want, and add video, image,
sound, or real-time graphics in layers. The Timeline pane displays the layered content
of one Timeline.
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Note

Do not confuse the Timeline pane with the Timelines pane, which contains
all the Timelines and Timeline Groups in a given scene.

Figure G.9. Timeline layers

G.6.1 Timeline playback and element-manipulation controls

Figure G.10. Timeline playback and element-manipulation controls

From left-to-right the Timeline playback and element-manipulation controls are:

Go to Start: Moves the Playhead to the start of the Timeline.

Last Frame: Moves the Playhead to the last (previous) frame.

Play/Pause: Plays or pauses the Timeline.

Stop: Stops the Timeline.

Next Frame: Moves the Playhead to the next frame.

Go to End: Moves the Playhead to the end of the Timeline.

Snapping On/Off: Turns Snapping mode On or Off.

When in Snapping mode, elements on the Timeline can snap
to other elements. When dragging an element, a visual marker
indicates if snapping is possible. If snapping is possible, releas-
ing the element snaps it to the visual marker.

Align Left: Aligns two or more elements to the leftmost element.

Select the elements to be aligned and click this button to align
them.

Align Right: Aligns two or more elements to the rightmost element.

Select the elements to be aligned and click this button to align
them.

Same Width: Sets the length of two or more elements to that of the longest
selected element.
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Select two or more elements and click on this button to set the
length of all selected elements to that of the longest element.

Add TimeCue: Adds a TimeCue at the position of the Playhead.

G.6.2 Zooming

Figure G.11. Zooming controls

From left-to-right the Timeline zooming controls are:

Zoom out: Zooms out on the Timeline.

You can also zoom out by using the mouse scroll
button.

Keep Center while Zooming: Keeps the center of the Timeline fixed while zoom-
ing.

By default, zooming is fixed on the left of the
Timeline. This button overrides the default.

Zoom in: Zooms in on the Timeline.

You can also zoom in by using the mouse scroll
button.

Hide Minimap: Hides the minimap, which is above the controls.

G.6.3 TimeCue

A TimeCue is a time marker that belongs to a specific Timeline. A Timeline can be
started at a given TimeCue from external Timelines or events using the Go-to-Cue
Timeline action. You can add a TimeCue using the Add TimeCue icon or by right-
clicking on the time strip.

G.6.4 Keyframing

A Keyframe is a property value of a Timeline element, mapped to a specific time on the
Timeline. Keyframing allows the smooth transition from one value to another. For more
information on Keyframing, see Keyframing (p.134).

G.6.5 SMPTE configuration

1. Select the Master Player, which should be the Player with a bold colored
outline, from the Output control.
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2. Choose the correct input device in the Audio devices section of the
Player’s Properties pane.

Figure G.12. SMPTE device configuration

3. Configure the Master Player.

4. Launch the Master Player.
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Figure G.13. SMPTE signal quality gauge

In the Output’s layout you should see the SMPTE signal quality gauge
moving. If you don't see anything, it means that either the signal is too
dim or the chosen audio device has to be changed.

Note

You must launch the Master Player to see any effect. If the
Master Player is not running, the Timeline does not react to
the SMPTE signal. Running only the designer does not cause
the signal quality gauge to react to the SMPTE signal, even
if the Master Player is set to run on the same machine.

G.7 Properties pane
The Properties pane gives access to all user-editable elements. To access the properties
of any user-interface element, click on the element to open its Properties pane.
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G.7.1 Video and image properties

Figure G.14. Video properties for a Timeline element
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Properties

Name: Displays the name of the timeline element.

Start Time: Shows the time at which the element starts playing on the
Timeline.

Length: Shows the duration of the element.

Only play on: Allows selection of the player on which to play the element.

Surfaces: Allows selection of either Displays or 3D Objects and then
selection of the surface on which the element is to appear.

Mapping: Allows choice of media perspective.

Stretch Mode: Allows choice between Best Fill, Fill Height, Fill Width, and
Stretch modes.

Composite Mode: Allows choice between Add, Multiply, Replace, and Screen
modes.

Canvas Texturing: Associates displays automatically with the correct crops, when
you add a package to the Timeline.

Loop: Loops the media.

Free running: Allows media to play when the Playhead is paused inside the
element.

Mask: Uses the element as an alpha mask.

Disabled: Disables the element.

When the surface is a display, media can be moved in the display, as it can be moved
in 2D mode, by using its camera menu to switch the Viewport's view to the screen. See
2D media manipulation (p.122).

Video

The Video subpane provides a preview of, as well as detailed information about, a video
file. You can also open the file in the default Windows app or open the containing folder
using the icons.

Slicing

The Slicing subpane allows the user to play only a certain part of the video by selecting
the start and end time. The use can either enter those times in the Start and End fields,
or use the ruler.

Transition

Fade In Time: duration of fade-in

Fade Out Time: duration of fade-out
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Color Correction

The industry-standard parameters for color correction are:

Gamma: the gamma correction factor

Min Input: the minimum input value (black)

Max Input: the maximum input value (white)

Hue Offset: the hue offset, represented as an angle between −180 and 180 on a hue
wheel

Saturation: the saturation boost factor, between −100% and +100%

Brightness: the brightness boost factor, between −100% and +100%

The Reset button resets the color correction properties to their default values.

The properties for an image are the same as the properties for a video, except there are
no Slicing, Loop, or Free running options.

Input properties

Figure G.15. Properties pane for an input

Name: Enter the name of the input.

Type: Select between TUIO and OSC.

Port: Enter the port to listen to.
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Figure G.16. Properties pane for an input variable

Type: The type of variable can be float, int, or bool.

Default Value: The default value of the variable.

Range: Enter the values received in the text boxes and select
to what they are remapped with the slider.

Can Trigger Parent Event: Select or deselect to determine whether or not the
value change can trigger the parent event.

G.8 Inputs pane
The Inputs pane allows you to create open sound control (OSC) and tangible user inter-
face object (TUIO) inputs that can then be used to control real-time media elements in
your project.
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Figure G.17. Inputs pane

G.8.1 Input variables

Once an input is created and receives input through the specified port, real-time feedback
concerning the input's contents is displayed. Each TUIO or OSC input displays a list of
incoming variables, each of which can be dragged and dropped onto action parameters.
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Figure G.18. Input variables

Configuring OSC and TUIO inputs

G.8.1.1.1. Configuring TUIO

To configure TUIO, select the input from the list and the properties will appear in the
properties pane on the right. You can set the Name, Type and Port of the input. If the
TUIO input is feeding data on the selected port, information will appear automatically
under the input in the list.

G.8.1.1.2. Configuring OSC

To configure OSC, select the input from the list and the properties will appear in the
properties pane on the right. You can set the Name, Type and Port of the input. If the
OSC input is feeding data on the selected port, information will appear automatically
under the input in the list.
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G.8.1.1.3. Input properties

See Input properties (p.108) for examples of the Properties pane for inputs and input
variables.

G.8.2 Connecting variables to actions

Input variables can be assigned to almost any action parameter in order to modify it in
real time. Simply drag and drop the input variable into the action parameter field to
bind them.

Figure G.19, “Moving a "blob" using its x and y positions” shows an example using the x
and y positions of a detected moving object ("a blob") to move a 3D object in X-Agora's
3D environment (using the moveNode behavior).

Figure G.19. Moving a "blob" using its x and y positions

Here is another example in which a new blob that will be a trigger to play a Timeline
(using the startTimelineOnEvent behavior) is detected.
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Figure G.20. Detecting a "blob" that will trigger a Timeline

G.9 Viewport
The Viewport pane provides up to four distinct views of the 3D scene in order to facil-
itate viewing and moving 3D objects and displays.
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Figure G.21. Viewport

G.9.1 Changing the number and layout of views

Click on the Views Template button, in the top right-hand corner of the Viewport pane,
to change the number and layout of views.
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Figure G.22. Views template

G.9.2 Camera and controls

To change the Camera assigned to a Viewport, click the Camera name to the right of
the icon in the top left-hand corner of a Viewport frame. The projectors and screens
listed in the Displays pane, as well as default cameras such as Top, Front, Left, Right,
Bottom, Perspective, and Orthographic, are available here.

To move the camera in the Viewport, a toolbar provides different movement modes:
Selection, Pan, Orbit, and Zoom. When using the tool explicitly, the left mouse button
behaves according to the selected tool.

To move or scale selected objects in the scene, use the 3D manipulator with axes.
Dragging an axis moves or scales the selected objects along that axis. Right clicking in
the Viewport while an object is selected opens a menu that allows you to change between
the move and scale manipulators. When using the move manipulator, Shift+O toggles
between local and world axes. All the scale, dimension, and rotation properties of an
object can be edited in the Properties pane.

All camera controls and object controls can be triggered by using keyboard shortcuts,
as described in Viewport keyboard and mouse shortcuts (p.191).
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Figure G.23. List of cameras

G.10 Settings pane
The Projection study section of the Settings menu provides access to key features of the
Projection Study Tool.
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Figure G.24. Settings pane

Unit: Choose between metric and imperial units of measure.

Surface gain: Set a value between 0.0 (100% absorption) and 1.0 (100% diffusion).

Some special surfaces can also have a gain greater than 1.0. Surface
gain indicates how much the surface on which you are projecting
diffuses back the light.

The following settings define the mapping of a range of values to the color gradient.

Min luminance: Set the minimum acceptable luminance level.

Max luminance: Set the maximum desired luminance level.
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Min resolution: Set the minimum acceptable resolution.

Max resolution: Set the maximum desired resolution.

The Preferences section of the Settings pane allows you to toggle ON or OFF the project-
ors in a Timeline layout and the reference grid.

Barco Pn: 60600320118

Appendix G: Window menu panesBarco Media Server XHD-Series User Guide



Appendix H: Tools
This appendix contains information on several X-Agora tools.

H.1 2D mode
Use the 2D mode to create projects that do not need to include 3D elements.

The 2D mode uses a simplified workflow, removes some of the more complex concepts
from the 3D mode, and is optimized for 2D performance. Overall, the 2D mode is still
very similar to the 3D mode, and most of the information that can be found in these
appendices, while written for the 3D mode, is also accurate for the 2D mode.

Select the 2D checkbox in the New Project dialog to create a new 2D project. See .

Figure H.1. Create new 2d project

H.1.1 Workflow

The workflow in 2D mode is very similar to the workflow in a 3D project. Most of the
3D layouts are still present and fill the same purposes. The main differences are that
there is no projection study layout, and that the viewport displays a 2D scene instead
of a 3D environment, where all units are in pixels. The concept of screens and projectors
is also abstracted as displays, and a stage is used to define the 2D space in which your
show is built.

1. Create a new 2D project.
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2. Define the stage dimensions based on what is needed for the project.

3. Create displays and position them in the stage.

4. Add timelines and media as in 3D mode. 2D media manipulation and
Keyframing can be used if needed.

5. Proceed with calibration, output control, and playback as in 3D mode.

H.1.2 2D concepts

Stage

Figure H.2. Stage

The stage is a 2D workspace in which your project is built. The stage is a visual reference,
giving you a way to build boundaries within which to work. No restrictions force you
to place displays and elements within the stage, but it is strongly suggested that you
do so for convenience. The stage is defined by its width and its height in pixels. You
may access these properties by using the gear icon in the Viewport's toolbar.

Note

The size in pixels of the stage itself has no effect on performance whatsoever.
A stage can be defined to be as large as is necessary.
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Displays

Figure H.3. Displays

A display is the equivalent of projectors or screens in 3D mode. It is an output that can
be connected to a player. In 2D mode, the concept of display is more abstract than in
3D mode; it doesn't matter if the physical output is a projector or a screen. A display is
defined by its resolution, along with its position in the scene and rotation.

Because all units in 2D mode are pixels, the resolution of a display can be defined both
in stage pixels and native pixels. This is necessary to emulate differently sized displays
with the same resolution. For instance, two HD screens of different physical sizes can
be connected to your scene's displays, but if you want to have media transitioning
between the screens that keep the same physical size, one display will need to be bigger
in your scene, even if they have the same native resolution. The size in pixels in the
scene is defined as the Stage Resolution. By default, the native and stage resolutions are
the same. To have different values, uncheck the "Use Native Resolution" checkbox.

A display's properties can be modified in the Properties pane. The position, rotation,
and size (if Use Native Resolution is unchecked) can also be modified by using an adorner
in the Viewport, the same way as 2D media.

H.1.3 Controls

When in 2D mode, the controls in the Viewport are slightly different than in 3D mode.
The Viewport can only be panned or zoomed. The mouse controls for those actions are
the same, however the middle-mouse-button click-and-drag pans the Viewport, and
the middle-mouse-wheel zooms in the Viewport. Use the left-mouse click to make se-
lections. A right-mouse click opens a contextual menu based on the selected elements.
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Figure H.4. Toolbar

A toolbar is also available to handle Viewport manipulation, along with other 2d-mode
features. The Select, Pan, Zoom In, and Zoom Out tools allow you to use their respective
manipulation modes. The Zoom-to-Fit icon centers the Viewport on the stage. The
Snapping icon enables or disables snapping for displays and media element manipula-
tion. The Lock Displays icon locks or unlocks the selection of displays. The Stage Prop-
erties icon shows the stage's properties in the Properties pane.

H.1.4 2D media manipulation

In order to move and resize media more easily when in 2D mode (or when in a screen
in 3D mode), adorners, align and fit options, snapping, and other highly visual and in-
teractive features are available. Most of an element's properties can be set by using the
Properties pane, but these tools provide a generally more efficient and intuitive way to
work with media.
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Figure H.5. 2D media manipulation

To add media to a Timeline in 2D mode, you can still drag the media on the Timeline,
but it is also possible to drag the media directly in the Viewport. Doing so adds the
media at the current playhead time on the current Timeline at the 2D position at which
it was dropped in the Viewport. The layer on which the media is placed is the topmost
free layer at the current playhead time.

Media can be manipulated in this way only when a Timeline is paused. Only the media
displayed at the paused time can be selected and manipulated, and the media must be
on the currently active Timeline. If a media satisfies these criteria, it can be selected in
multiple ways. As in 3D mode, clicking on the Timeline element selects it. In 2D mode,
it is also possible to select the media elements directly in the Viewport by clicking on
them. A selection rectangle on left-mouse click-and-drag can be used to select multiple
elements on the Timeline, as in the 3D mode, and also in the Viewport. Multiple selections
can also be performed in the Viewport by using Ctrl-click.

Selected media show an adorner in the Viewport. The adorner can be used to move (by
dragging the adorner), rotate (by using the rotate gizmo), and resize (by dragging the
corners) selected elements. Hold the Shift key to preserve the aspect ratio while resizing.
When moving media, snapping to adjacent elements can be toggled on and off by using
the Viewport's toolbar icon.

123Barco Pn: 60600320

Barco Media Server XHD-Series User GuideAppendix H: Tools



Figure H.6. Adorner manipulation

When multiple elements are selected, fit or align options are available to move and
resize your media by using a right-click menu in the Viewport. The align options allow
you to align multiple elements to the top, middle, bottom, left, right, or center of the
selection. The fit options are available only when media and a display are selected. In
3D mode with a screen, the display is implicitly the screen, so no displays need to be
selected. The fit options allow you to fit the media's width and height in relation to the
display (Fit width or height, best fit or stretch).
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Figure H.7. Fit and Align

When Keyframing is enabled for a media's position, dimension, or rotation, using the
2D adorner instead applies the operation for the current time's Keyframe. For more
details, see Keyframing.

H.1.5 Differences from 3D mode

• The Projection Study Layout and Projection Study Wizard are unavail-
able.

All display creation and moving should be done in Programming Layout.

• The size and position of all elements are in pixels.

There are no real-world units.

• The Content Production Tool is unavailable.

• Reverse Calibration is unavailable.

Reverse Calibration works only in a 3D environment. The default calib-
ration tool is Keystone.

• The 3D Scene Pane and 3D objects are unavailable.

• The list of Actions is limited to actions that are relevant to 2D.

• Settings and media properties are simplified.
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H.2 X-Agora Agent
The X-Agora Agent runs on each computer in the X-Agora network, coordinating and
synchronizing each player application in the network with the central server. In short,
the agent links each machine with the brains of the operation—the server.

Figure H.8. Agent icon in the tray

Double-clicking on the Agent icon in the notification area opens the Agent interface,
displaying the Configuration tab.

The Configuration tab allows you to point the Agent towards:

1. the X-Agora Player executable.

2. the media file directory.

Figure H.9. Agent Interface
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Clicking the Agent Logs tab exposes logs of the activities of the Agent, as well as its
communication with the server. Logs are useful for debugging connection problems,
or identifying missing media files.

Figure H.10. Agent logs

H.3 X-Agora Media Encoder
X-Agora Media Encoder is a tool meant for encoding videos—either from image se-
quences or from existing videos—to eventually re-encode them. You can also use the
Media Encoder to crop full-resolution image sequences or videos, creating video packages
that conform to the crop definitions generated in your study. See the section Content
Production for details on how to generate cropping templates to split your high-resolu-
tion media files for multi-screen output.

H.3.1 Application preferences

Go to Tools → Preferences (or type Ctrl-Q in the application) to open the application
preferences.
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Figure H.11. Application preferences

Application settings

The dialog box displays the following information.

Crop definition file: the global crop definition file.

If encoding jobs are set to perform cropping and do
not have a local crop file or are set to not use the
local crop file, they will use this global crop defini-
tion file.

Supported source movie exten-
sions:

a list of file extensions that X-Agora recognizes as
movie files.

Supported source image exten-
sions:

a list of file extensions that X-Agora recognizes as
image sequences.

Frame rate for image sequences: the frame rate to use for the output video of image
sequences.
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Encoding quality: encoding presets, with details about the output co-
dec, maximum number of supported layers in X-
Agora, and disk space estimates.

Click on the Reset button next to the setting to apply the default values of a setting.

Encoding presets

The X-Agora Media Encoder offers four encoding presets.

• SQ: Standard Quality (MPEG-4). This is the default preset, and it is the
first one you should try, because it is the optimal tradeoff between
compression quality and disk space.

• HQ: High Quality (x264). This preset performs some compression, but
results in virtually unnoticeable quality loss.

• XQ-S: Extra Quality Small Files (x264). This preset performs lossless
compression with relatively small files, but encoding and decoding are
longer than usual.

• XQ-L: Extra Quality Large Files (FFVHUFF). This preset performs lossless
compression with quick encoding and decoding, but the resulting files
are larger than usual.

H.3.2 Single video encoding

To start encoding an image sequence, drag the folder containing the images inside the
job list section. A new job appears in the list, and the new job can then be started, paused,
or stopped. To re-encode a video, repeat the process by dragging the video to be re-en-
coded instead.

H.3.3 Video package encoding

Video package encoding is useful when the image sequence or video has been produced
from a 2D or 3D template generated by the X-Agora Content Production Tool. A package
is simply a folder containing the sub-sections of the content to be played by each indi-
vidual projector output. The package contains several videos named after each projector's
internal identifier. Follow these steps to use video-package-encoding packages:

1. Place the crops.xml file in a folder with the image sequence and import
the folder into the Media Encoder.

An encoding job appears in the list. You can also choose to globally
apply a crop definition for all future encoding jobs by going in to the
application settings.

2. Press Play to start the job.

3. Import the generated video package into the Media Pane of your project.

4. Place the package on a Timeline.
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5. Select the package on the Timeline to expose its properties.

6. Enable the Canvas Texturing option.

If the content-splitting option was enabled when the Viewpoint was created in the
Content Production Tool, you must also apply the split on the image sequences to pro-
duce a video package.

Figure H.12. Media Encoder

Figure H.13. Media Encoder job

H.4 Content Production
The Content Production tool allows you to produce image sequences for X-Agora.
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Figure H.14. Content Production tool

The Content Production tool allows you to:

• Create cropping templates for motion graphics and video artists tasked
with creating content for large-scale, multi-screen or multi-projector
pixel spaces.

• Visualize, with a special shading, the relationship between content pixels
and projected pixels in order to find the optimal resolution for the tem-
plates.

• Visualize any discrepancy between projector coverage and template
coverage, and vice versa.

H.4.1 Viewpoints

A Viewpoint is a virtual representation of a point of view from which content can be
created by video and motion graphics artists. Content can be created for ISO or perspect-
ive templates. Most of the time you can use ISO, unless you are creating visual effects
to be seen from a specific perspective.

H.4.2 Viewpoint properties

Viewpoints share many properties with projectors: Projector position, Target position,
Roll, Portrait or Landscape orientation, Color, Show cone, and Show measurements.
Other properties include:

Dimension/View angle: Defines the size of the area covered by the Viewpoint.
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Align to object: Aligns the Viewpoint to a selected surface. The View-
point is positioned to look at the surface, and its dimen-
sions will be large enough to cover the surface entirely.

Resolution: Defines the resolution of the viewpoint, which becomes
the resolution of the exported template.

Split content: Specifies the projectors for which content produced from
this Viewpoint will be cropped. Only one Viewpoint can
be used to split content.

Export template: Exports the image seen from the viewpoint, which can
be used as a template by the artists. If the viewpoint has
split content enabled, crops are also exported in a
crops.xml file, and output an image defining all the crop
regions.

H.4.3 Crops and packages

The Content Production tool allows you to generate a cropping template from a partic-
ular Viewpoint. See Generating a cropping template (p.157) for more information.

H.5 Remote mode
Use remote server mode to access a server from a remote machine on a local network.

For example, when you're doing calibration, it's usually practical to be able to move
around the surface, something you cannot do easily from the server. With the Remote
Server mode, you can just connect to the server using a laptop and continue your work
seamlessly. Once calibration is done, you can just go back to your server and continue
working on your project.

Figure H.15. Connect to Remote Server
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H.5.1 To enter Remote Server mode

1. Select File > Connect to Remote Server.

2. Select from the list the host with which you want to connect, and select
OK.

Note

The Agent must be running on the remote machine to
which you want to connect. The window title changes to
(Remote Control) if connection is successful.

Every action you do in Remote Server mode is now mirrored on the remote machine.

You cannot perform the following actions while in Remote Server mode.

• Create a New Project

• Add or delete media

• Import 3D models

H.5.2 To exit Remote Server mode:

1. Select File > Connect to Remote Server.

2. Select the localhost.

H.6 Live input
X-Agora allows you to integrate live video feeds into your show. Simply place a Live
Feed media element on your Timeline and configure it to read your live video-capture
hardware.

Note

Make sure your live video feed capture hardware is connected to the
player machine that will output it to display hardware.
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Figure H.16. Live input on the Timeline

1. Make sure you have a player configured in the Outputs layout and
that the player’s virtual inputs are properly mapped to the physical
live-capture hardware that is connected to the player machine.

Note

Live-capture hardware must be connected to the player
machine that will output the Live Feed visual.

2. Drag a Live Feed media element onto the Timeline in the Programming
layout and select that Live Feed media element to expose its properties.

3. Select a virtual Input Device from the drop-down menu.

This is the virtual input device was mapped to your physical input
device in step 1.

4. Select a surface from the drop-down menu on which to display the
Live Feed.

H.7 Keyframing
To enable Keyframing for a specific property, click on the orange diamond next to the
keyframable property. See Figure H.17, “Keyframe activation”.
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Figure H.17. Keyframe activation

Once activated, a keyframe layer appears on the lower section of the timeline. Each
keyframe is represented by a diamond.

Figure H.18. A Keyframed Timeline Element

H.7.1 Animating an element's position

To animate the position of a media element, move the playhead forward in time and
start dragging the media element. If you are in a 3D project, you must select a screen in
the Viewport pane. When you drag the element, a line showing the actual path of the
movement appears in the canvas. A yellow diamond shows the location in space of each
keyframe, and the small yellow dots represent intermediate positions (every ten frames).
You can judge how the speed of the element varies along the path. The further apart
the points are, the faster the element is. See Figure H.19, “Animated position trail”.

You can repeat the process—move the playhead in time and drag the media element at
the desired location—and keyframes are generated automatically.

135Barco Pn: 60600320

Barco Media Server XHD-Series User GuideAppendix H: Tools



Figure H.19. Animated position trail

H.7.2 Inserting keyframes

For the position property, new keyframes can be inserted directly in the canvas by hovering
the cursor over the path. When the cursor is over the path, a + appears next to the
cursor, indicating that the next click will insert a keyframe at this location. See Figure H.20,
“Inserting a position keyframe”.

Figure H.20. Inserting a position keyframe

For non-position properties, new keyframes can be inserted in either of two ways.

1. Click on the plus sign on the left side of a keyframe layer, or

2. Unfold the layer to show the actual curve and hover the mouse at the
desired location.

Figure H.21. Inserting a keyframe with the + button
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Figure H.22. Inserting a keyframe by hovering

Notes to Figure H.22, “Inserting a keyframe by hovering”

1. Unfold the layer.
2. Hover and click to insert keyframe.

You can move the Keyframe left and right anywhere on the Timeline. Whenever a
Keyframe-enabled property is modified, the value of the Keyframe at the current play-
head position is updated. If no Keyframes are present at that time, one is created with
the new property value. The interpolation between values can be either Spline or Linear.
You can select the interpolation mode by using the icon next to the property name. You
can also move between Keyframes by using the left and right arrows.

H.7.3 Tangent control

You can fine tune animation curves by manipulating the slope of the curve at each
keyframe. To enable tangent control…

1. Make sure the interpolation mode is set to Spline by clicking on the
Spline icon.

2. Unfold the animation layer to make the curve appear.

3. Click on a keyframe to make the tangents appear.

Once tangent control is enabled, you can click and drag the tangent endpoints to fine
tune the shape of the curve.

Figure H.23. Tangent control

Notes to Figure H.23, “Tangent control”

1. Spline icon
2. Handle

By default, X-Agora ensures that the curve keeps a smooth slope, with no discontinuities.
If you want to change that and allow the curve to have spikes and angles, select the
keyframe and uncheck the "Symmetric" property.
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Figure H.24. Symmetric tangent property

Figure H.25. Curve with non-symmetric keyframe tangents
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Appendix I: Workflow layouts
The right-hand side of the menu bar at the top of the X-Agora interface allows you to
choose from among the five workflow layouts in X-Agora: Study, Programming, Outputs,
Calibration, and Playback.

I.1 Project Study layout
Assessing and documenting the various options for projector placement, and the ad-
vantages or disadvantages for each option, is referred to as a "projection study.” The
Projection Study layout allows you to generate detailed technical plans of projector
placement options.

To switch into the Projection Study layout, select Study from the menu bar in the top
right-hand corner of the X-Agora interface, as shown in Figure I.1, “Study on the menu
bar”.

Figure I.1. Study on the menu bar
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I.1.1 Layout purpose and workflow

The Projection Study layout is mostly used in the initial phases of a production. It is the
layout best suited for creating your 3D scene and arranging your displays. You can
create multiple display configurations, and produce a study document to detail and
evaluate each configuration. If there is no need to produce such documents, you should
still use the Projection Study layout to create your scene and displays, because this layout
has features that may help people working at a more technical level: technical directors,
architects, and integrators.

The usual workflow in the layout as follows:

1. Create your 3D scene.

2. Create and set the properties of displays, and evaluate the luminance
and resolution quality of your display or projector configuration by
selecting a visualization mode.

3. Create and arrange pages for the printable document that details crucial
information concerning the advantages and disadvantages of each
configuration.

4. Export or print the resulting document.

5. Repeat steps 2 to 4 for different display configurations if necessary.

Optionally, for complex projects, once a final display configuration has been chosen,
use the Content Production tool to create 2D templates for the artists to work in the
scene. If your project contains only flat surfaces, this step can be ignored, because the
mapping of media on flat surfaces can be done easily by using the media element
properties in the Programming layout.

I.1.2 Viewport

The Viewport pane is where most manipulation and visualization of your 3D scene oc-
curs. Because most 3D object manipulation should be done in this layout, it is important
to know how the Viewport works. See Viewport (p.113).

I.1.3 Scene creation workflow

The workflow to create the 3D objects and displays in the Projection Study layout de-
pends on what type of project you are creating and what are the possible display con-
figurations. The workflow presented here is one for the most complex projects, where
external geometries need to be imported. Depending on the nature of projects, some of
these steps may be omitted or altered.

1. Import a 3D model (.fbx, .obj, .dwg, .dxf, .svg).

For CAD file formats (dwg, dxf, svg), if you want to project on the im-
ported model, it must be made out of faces and not only lines.
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Importing 3D objects in X-Agora can be done in many ways; see Import-
ing 3d objects (p.143).

Figure I.2. Import 3D model

2. Make sure that the imported model's scale is in proportion to the X-
Agora 3D space and that it is properly positioned.

a. The default unit scale of the X-Agora 3D space is 1
unit = 1 m.

b. To adjust the scale or position of your model, select
the model in the player Viewport or the 3D Objects
pane and then click on the Properties tab to expose
its position, scale, and dimension properties.

c. To change between metric and imperial units, go to
the application settings.
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Figure I.3. Create a 3D object

Figure I.4. 3D Object Properties pane

3. Create projectors to cover the imported projection surfaces using the
Create Projector Array function.

If you select a single object and click on Create Projector Array in the
Properties pane, X-Agora automatically detects the projection area by
choosing the biggest surface of the selected model. The Projection Study
Wizard then creates the required number of projectors.
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Note

In the event that you are using X-Agora to project onto a traditional flat
surface (screen or otherwise), you can use the Projection Study Wizard from
the Tools menu. This creates a projector array and also a screen that can
be used as a projection surface. When using the Projection Study Wizard this
way, you can manually enter the coverage area dimensions.

Figure I.5. Projection Study wizard

I.1.4 Importing 3d objects

Importing 3D objects in X-Agora can be done in many ways. You can import objects by
using the File menu of the X-Agora interface, the Add Object menu of the 3D Objects
pane, or by dragging a valid file directly in the Viewport. X-Agora can import many
file formats, however, because each file format stores different information, not all file
formats have the same possibilities once they have been imported.

The supported file formats are .fbx, .obj, .dwg, .dxf and .svg. Those file types can be
separated in two categories: modeling software formats (.fbx, .obj) and CAD drawing
formats (.dwg, .dxf and .svg). The most complete file format for X-Agora is .fbx, however
you may not have control over which of those formats can be used, because the models
are usually provided by an external source. (See Supported 3D formats (p.192) for more
information.)

I.1.5 Using the Projection Study Wizard

Using the Projection Study Wizard, you can easily define a projection pixel space in
your 3D scene. Once your model has been imported, you can use the Projection Study
Wizard to automatically generate an array of projectors to cover the specified pixel
space. The Projection Study Wizard can also create a screen that matches the pixel space.

To open the Projection Study Wizard, select the Tools in the menu bar, and select Pro-
jection Study Wizard from the Tools menu. You can also select an object from your
scene and click the Create Projector Array button in its properties.
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Projection Study workflow

1. If no object is selected, choose between aiming the projectors horizontally
at a Wall or vertically at a Floor.

2. If no object is selected, define projection dimensions.

3. Adjust "Distance"/"Throw ratio."

Keep in mind that these are relative parameters. Change one, and the
other is adjusted proportionally.

4. Choose an aspect ratio setting.

"Auto" mode chooses a combination of aspect ratios to best conform
to the desired coverage area. Alternatively, you can set all projectors
to a fixed aspect ratio.

I.1.6 Projection Study Wizard interface

Figure I.6. Projection Study Wizard interface

Projector surface

Use these settings to simulate the physical surface that will be projected upon.

Type: This setting, Wall or Floor, defines the orientation of created project-
ors.
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Size: Size defines the pixel space in m, cm, mm, ft, or inches.

Luminance: Luminance of the projection surface in candela per square meter
(cd/m2) or candela per square foot (cd/ft2).

This parameter should generally remain the default setting of 130,
unless projection is to take place in a bright environment, such as
outdoors during the day.

Surface Gain: Surface gain is the extent to which the surface on which you are
projecting absorbs or reflects light. Values fall between 0.0 (100%
absorption) and 1.0 (100% reflection).

Pixel size: Pixel size defines the physical width of a projected pixel in milli-
meters.

Projector

Use these settings to simulate the physical surface that is to be projected upon.

Brightness: Simulates real-world projector brightness setting.

Stack Count: Represents the number of projectors per stack.

Distance: Measures the distance of the projectors from the projection surface.

Throw Ratio: This is a property defined by the quality of the lens used on the
projectors.

Aspect Ratio: "Auto" mode automatically chooses aspect ratios for optimal cover-
age.

Orientation: "Auto" mode determines a combination of projector orientations to
guarantee optimal coverage.

Resolution: Represents the resolution of each projector in the array.

Min Overlap: Shows a percentage of overlap between each projector.

Group Color: Shows the color of the group of projectors being created.

I.1.7 3D objects pane

The 3D Objects pane provides a list of all the 3D objects in your scene. It also allows
you to select them individually in order to highlight them in the Viewport and expose
their parameters in the Properties pane. For more information, see 3D objects pane (p.101).

3D Objects workflow

1. To expose and edit the properties of a 3D object, select the object in the
3D Objects pane.
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Figure I.7. 3D Objects pane

2. To import or create a new 3D object, or to create a New Measure, press
the + button on the top right of the 3D Objects pane.

Figure I.8. Create a 3D Object

Use the + button to create a 3D primitive (a plane, sphere, or cube), to
create a light or Measure, or to import a 3D model created with third-
party 3D modelling software. Each object in the 3D Objects pane can
be renamed, duplicated, hidden, or locked.
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Measures workflow

Measures are powerful tools with many uses. A Measure can be used to calculate a
distance between objects, display this information on a page, or to resize an object based
on a known real dimension.

When you create a Measure by using the 3D Objects pane, the Measure's properties
appear in the Properties pane.

Follow these procedures to create and manipulate a Measure:

1. Click the + button in the top right-hand corner of the 3D Objects pane.

2. Select New Measure from the drop-down menu.

3. Enter a name for the Measure.

4. Click on the target icon next to First object to pick the first point.

Clicking on and dragging an object in the 3D view changes its position.

Position can also be adjusted manually by entering the coordinates in
First Position (M) fields.

5. Click on the target icon next to Second object to pick the second point.

Clicking on an object in the 3D view causes the measurement to appear
automatically between the two objects in the 3D view. Moving one of
the two objects also moves the Measure and changes its Distance
property.

6. Click on the Color picker icon to modify the color of the measurement.

7. Click on X/Y/Z Decompose to decompose the Measure on the X, Y,
and Z axes.

8. Click on the Detach icon to detach a Measure.

9. Press delete when a Measure is selected to delete the Measure.

I.1.8 Displays

Once you have created your displays (either manually or by using the Projection Study
Wizard), you can make adjustments to your displays by using the Displays pane, which
can be accessed in the Projection Study layout or from the Window tab on the menu
bar at the top of the screen. Once you have created your displays (either manually or
by using the Projection Study Wizard), you can make adjustments to your displays by
using the Displays pane, which can be accessed in the Projection Study layout or from
the Window tab on the menu bar at the top of the screen.

For more information, see Displays pane (p.93).
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I.1.9 Studies and pages

Projection Studies

A projection study is a configuration of displays in your scene. When creating a new
project, a default study is created, but you can add more studies if you need to assess
different display configurations. These studies contain pages, showing different elements
of your study, which can be printed or exported to PDF. The layout of what is printed
or exported is "wysiwyg," what you see in the Viewport is what you get in your docu-
ment.

• To create a new Projection Study, click on the + in the Study layout
toolbar, in the upper right-hand corner of the Viewport, and select New
Study from the drop-down menu.

Figure I.9. New Study

• To switch between Projection Studies, click on the Default Study tab in
the upper left-hand corner of the Viewport, and select a study from the
drop-down menu.

Figure I.10. Switch between Projection Studies
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Pages

• To create a new Page in the current Projection Study, click on the + in
the Study layout toolbar, in the upper right-hand corner of the Viewport,
and select New Page from the drop-down menu.

Figure I.11. New Page

Pages have different properties, which the Properties pane displays, when you click on
the Page tab in the Viewport. Pages can be printed or exported to PDF from the Properties
pane of the page.

Visualization mode

Visualization modes are among the most crucial features of Pages. Each visualization
mode displays a heat map to indicate areas of high and low quality luminosity or resol-
ution, based on display placement.
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Figure I.12. Visualization mode

Luminosity visualization mode indicates the luminosity quality across the projection surface.

Resolution visualization mode indicates the resolution quality (or pixel density) across the
projection surface.

The minimum and maximum values for the heat map can be set in the Settings pane.
The heat map displays values from blue to red. Values under the minimum or over the
maximum are shown with diagonal stripes. The heat map's scale is displayed in print
layout. It can also always be seen in the Properties pane of the Page.
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Figure I.13. Heat map

Print Layout

Two different layouts are available in the Viewport. The default layout is the Study
Layout, which is 3D-manipulation friendly. The other layout is the Print Layout, which
is the layout used to prepare a page for printing.

To switch to Print layout, click on Study Layout on the toolbar in the upper right-hand
corner of the Viewport, and select Print Layout from the drop-down menu.

Figure I.14. Change to Print layout
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More print-specific features are available in the Print layout.

• The Projector Specifications appear, showing the specifications of all the
projectors in the projection study.

• The Cartouche appears on the right of the Viewport.

In the Cartouche, you can specify a logo, a company name, an author
name, revisions, and notes.

• Notes can also be added anywhere in the Viewport, with any text.

Figure I.15. New note

The Projector Specifications, the Cartouche, and the Notes can be shown or hidden for
each page. To show or hide these items…

1. Click on the Extras icon in the toolbar, in the upper right-hand
corner of the Viewport.

2. Click on Show Notes, Show Cartouche, or Show Projector Specifica-
tions to toggle them On or Off.

A checkmark indicates that the item is toggled On.

Figure I.16. Hide elements of Print layout
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View styles

View styles allow you to customize how content is visualized, and can be used either
for Print layout or Study layout. A view style defines the colors to be used for the
background, the edges, and the objects.

Figure I.17. New view style

•

Figure I.18. Assign View Style 1

• To assign a view style to a view...

1. Click on the Extras icon in the upper left-hand corner
of the desired view.

2. Select View Style.

3. Select the view style, for example, View Style 1, from
the drop-down menu.
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Figure I.19. Assign View Style 2

I.1.10 Exporting templates with the Content Production tool

For a description of the Content Production tool, see Content Production (p.130).
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Figure I.20. Content Production layout

The Content Production tool allows you to:

1. Create cropping templates for motion graphics and video artists tasked
with creating content for large-scale, multi-screen or multi-projector
pixel spaces.

2. Visualize the relationship between content pixels and projected pixels
with a special shading, in order to find the optimal resolution for the
templates.

3. Visualize any discrepancy between projector coverage and template
coverage, and vice versa.

Viewpoints

A viewpoint is a virtual representation of a point of view, from which content can be
created by video and motion graphics artists. Content can be created for ISO or perspect-
ive templates. Most of the time ISO can be used, unless you are creating visual effects
to be seen from a specific perspective.

Viewpoint properties

Viewpoint properties share many of the same properties as projectors: Position, Target
position, Roll, Orientation, Color, Show cone, and Show measurements.

Dimension/View angle: Defines the size of the area covered by the viewpoint.
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Align to object: Used to align the viewpoint to a selected surface. It will be po-
sitioned to look at the surface, and its dimensions will be large
enough to cover it entirely.

Resolution: Resolution of the viewpoint, which will be the resolution of the
exported template.

Split content: Specifies the projectors for which content produced from this
viewpoint will be cropped. Only one viewpoint can be used to
split content.

Export template: Exports the image seen from the viewpoint, which can be used
as a template by the artists. If the viewpoint has split content
enabled, crops are also exported in a crops.xml file, and an im-
age defining all the crop regions is produced.
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Generating a cropping template

Figure I.21. Export template

To generate a cropping template from a particular viewpoint:

1. Select the viewpoint in the Viewpoints pane to expose its properties in
the Properties pane.

2. Click on the Export Template button in the Properties pane.

3. Save your template *.xml file in a folder, from which you can retrieve
it for use with the Media Encoder tool.
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4. Use the cropping template to crop content with the Media Encoder.

This produces a video package. The package can be dragged on the
Timeline like a video. To output the package from multiple player
machines, enable the "Canvas texturing" option for the video element.

Working with UV mapping

The use of content viewpoints can be limiting in some situations, for example:

1. Video projectors surround the projection surface on which you expect
to project from all angles.

2. The projection surface surrounds the video projectors.

In both scenarios, using a single content viewpoint is not enough to cover the whole
projection surface. In those situations, you might consider using the UV mapping
technique to achieve an 'all-around' projection.

UV mapping consists of unfolding a 3D model onto a flat surface, like a piece of clothing
is composed of multiple cut of 2D pieces tied together. This 2D unfolded version of the
model can then be exported as a 2D image, so that artists can draw into it, as they would
do inside a content viewpoint. The main difference is that a custom-made UV map allows
coverage of ALL desired angles for the projection surface.

Figure I.22. 3D cube
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Figure I.23. Cube UV map—unfolded

X-Agora does not include a UV Editor, and the "unfolding" process (called UV mapping)
of the 3D model should be done in a specialized 3D authoring software like 3DsMax,
Maya, Blender, etc. Then, simply export the 3D model into the fbx format to be loaded
in X-Agora. By default, all the content applied to the imported 3D object uses the UV
map exported with the fbx model.

It is also possible to use multiple UV maps, meaning different ways (called channels)
to unfold the 3D model, in the same fbx, and choose any map when applying videos or
images to the 3D model. To do this, in the Mapping property of the media in the timeline,
choose the channel you desire. There is a choice of up to 4 channels (UVSet0-3). By de-
fault, the first one is used.

I.2 Programming workflow layout
Once you have completed your projection study, select Programming from among the
workflow layouts on the right-hand side of the menu bar and start building content
Timelines.
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I.2.1 Layout purpose and workflow

The Programming tool allows you to build content Timelines. X-Agora allows you to
create as many Timelines as you want in each X-Agora project. Because it was designed
for large-scale installations, X-Agora also allows you to playback multiple Timelines
simultaneously. Large-scale installations often have multiple screen spaces, and often
it is easier to compartmentalize content for each screen space on a dedicated Timeline.
This is where Timeline Groups are useful for such compartmentalization. Timeline
Groups allow you to group together multiple Timelines in order to control them simul-
taneously or assign them playback priority.

1. Create Timelines and Timeline Groups in the Timelines pane.

2. Add media from the Media Pane to the Timeline.

3. Edit the Timeline and media's properties in the Properties pane on the
right.

4. Add actions, if needed, from the Actions pane onto the Timeline.

5. Play back the Timeline using the Timeline Playback Controls.

Figure I.24. Programming layout

See Window menu panes (p.93) for descriptions of the elements of the interface.

Barco Pn: 60600320160

Appendix I: Workflow layoutsBarco Media Server XHD-Series User Guide



I.3 Calibration layout
Use the Calibration layout to calibrate individual projectors when on site. X-Agora
features four projection calibration tools, most of which can be used in conjunction with
each other. The documentation for each tool outlines the other calibration tool with
which it should or should not be used.

Click on Calibration, on the right-hand side of the menu bar at the top of the screen, to
enter the Calibration workflow layout.

I.3.1 Calibration workflow

1. Select a projector from the list in the Projectors pane.

This enables the selected projector for calibration in the Calibration
pane.

2. Select from five different calibration tools: Reverse Mapping, Edge
Warping, Manual Blending, or Warping.

Each of these tools can be turned on or off by using a checkbox. The
calibration effect from those tools is applied in the order in which the
tools are displayed.

3. Click the Start button, in the Calibration pane, corresponding to the
tool.

When using a tool, the Viewport switches to display the image that is
to be projected by the selected projector.

Figure I.25. Calibration workflow layout
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I.3.2 Calibration interface elements

The main Panes used in this layout are the Displays pane, the Calibration pane, and the
Viewport pane. Timeline related panes are also visible, so that you can test with actual
content while calibrating. See Window menu panes (p.93) for descriptions of the elements
of the interface.

Note

Unlike the other layouts, the Calibration Layout displays the Calibration pane
by default, instead of the Properties pane. The purpose of this layout is only
to calibrate projectors, not modify their properties. If needed however, the
Properties pane can still be shown by selecting it from the Window menu.

I.3.3 3D calibration

Reverse mapping

Reverse Mapping is the preferred mapping tool when projecting onto a surface that is
not flat. This mapping tool requires you to have an accurate 3D model of the projection
surface onto which you are projecting.

The Reverse Mapping tool adjusts the position of projected material by moving arbitrary
3D points in the view. These 3D points should be placed correctly on the real model,
which allows the Reverse Mapping tool to deduce the real position of the projector and
create the proper projected image. Automatic blending is also calculated based on reverse
mapping of multiple projectors.

Note

Do not use the Reverse Mapping tool when using the Warping tool to do a
full-screen keystone.

Reverse mapping workflow

1. Select the projector you want to reverse map in the Displays pane.

2. Click the Reverse Mapping drop-down menu, in the Calibration pane,
and click Start Calibration.

3. Click Creation Target Mode, in the Setup section of the projector's
properties, and place a target on the geometry by left clicking in the
Viewport.

Targets should be strategically spread across key vertices of the geo-
metry - usually corners and other prominent features.

4. Left-click to place the real position of the target, shown by a green cross
at the correct position on the real physical model.
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5. Use arrow keys to position more accurately the real position of the
target.

6. Press enter to validate, once the position is properly set.

7. Repeat steps 3 through 6 until at least six targets have been positioned.

8. Check Enable Live Calibration to calculate the real position of the
projector and to adjust its output to match the targets.

9. If needed—move the targets until the projected image of the projector
matches as closely as possible the geometry upon which it is being
projected.

This may take many passes to perfect. Selecting a target on the geometry
is done by clicking it. Selected targets are shown as red, unselected
ones are shown as blue.

10. If needed—add more targets to fine tune the calibration.

Click Creation Target Mode and place additional targets on the geo-
metry. These targets can then be moved the same way as the initially
created targets.

If you need to delete a target, select it and press the Del key.

Right clicking with the mouse temporarily shows an all-white image, to help with cal-
ibration.

Note

A minimum of six points must be set before Reverse Mapping can be calcu-
lated.


Tip

When choosing the calibration points, follow these simple tips to make the
calibration as efficient as possible:

• Avoid choosing points lying in the same depth, the more
depth amplitude you have for your points, the easier the
calibration will be.

• Do not add too many points. The more points you add, the
less influence each point has when being dragged. You
should be able to calibrate efficiently with six or seven points.

Reverse Mapping controls

When not enabled, the following options can be set.

Show Points Toggles between showing and not showing the target points

Reset Removes all the target points
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When enabled, the following options can additionally be set.

Rendering Mode Identifies a specific rendering mode for calibration
purposes

Targets Transform Mode Specifies how moving a point influences the calibra-
tion (Freeform, Roll, Zoom, or Pan)

Do Not Blend With… Specifies for which other projectors this projector
should not calculate the automatic blending

Blending Toggles the automatic blending between enabled
and not enabled for this projector

Adjust Black Level Toggles the black level adjustment between “en-
abled” and “not enabled” and displays the value of
the black level multiplier

Dimmer Sets the value of the dimmer of this projector

Gamma Adjusts the gamma of this projector

Black Level Compensation Toggles the black-level compensation between “not
enabled” and “enabled” for this projector

The value can also be set, which affects how the
black-level compensation is spread.

Blending Optimization Toggles the blending optimization between "not en-
abled" and "enabled"

The KSet1 can also be set, which affects how the
automatic blending is spread.

I.3.4 2D projector calibration

Edge Warping

Use the Edge Warping tool to move or distort parts of the image projected by the camera.
Arbitrary triangles or quads in the image can be defined and moved. This tool can be
used along with any other tool.

Although it could be used to calibrate a projector by itself, this tool is best used to apply
small adjustments after the Calibration layout has been used to roughly calibrate the
projectors, or to move elements in a 2D display that have been output to a matrix.

As opposed to the Warping tool, which produces a smooth image, this tool is more
suited for shows that have geometric surfaces or content containing straight edges. The
Warping tool would smooth the edges, which could produce undesirable results, but
the Edge Warping tool allows you to exactly position a shape.

This tool is based around the concepts of points and shapes. Points are defined in the
image, and shapes (triangles or quads) are defined using those points. These shapes
and their points can then be moved, changing where those elements are placed in the
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resulting image. Moving points that are part of multiple shapes has an effect on all of
those shapes. If the user only creates a shape and moves it, the adjacent elements are
not modified, resulting in discontinuity in final image. If a shape is part of a mosaic-like
structure, however, where its points and edges are used in adjacent elements, moving
it adjusts the adjacent elements, keeping the resulting image continuous.

Shapes defined with this tool can also be used as all-black masks in the image.

This tool can be zoomed in or out and panned with the mouse wheel.

Figure I.26. Edge Warping workflow

Edge Warping workflow

1. Select Point Creation Mode (in the Global section or the Calibration
pane) and place points on the image in the Viewport pane.

Points should be placed at edge intersections, image corners, or at the
edge of content that is to be displaced.

2. Select three or four points by clicking on them.
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a. Multiple points can be selected using the Shift key.

b. Selected points are shown in red, unselected points
are shown in blue. By default, newly created points
are selected.

3. Click on Create New Shape (the Plus sign) to create a new triangle or
quad from the selected points.

4. Repeat Steps 1 to 3 as needed to create the points and shapes that you
need.

To delete a point or a shape, select it and press the Del key.

5. Move the points and shapes until the projected image fits accurately
on the surface.


Tips

If the image contains no empty regions, define a mosaic of
your whole image starting from the four corners, in order to
preserve continuity.

•

• Keyboard shortcuts can help defining points and shapes
faster.

• Ctrl+click can be used to create points.
• The F key and the Del key can be used to

create and delete shapes.
• Shift+click can be used for multiple selection

and deselection.

Edge Warping controls

The Global section of the Calibration pane provides controls for displaying points and
shapes in the Viewport pane.

Show Wireframe: Toggles between showing or not showing the shape wireframes.

Show Points: Toggles between showing or not showing the points.

Reset: Removes all points and shapes.

The Shapes section of the Calibration pane provides controls to create, delete, or modify
shapes.

Create New Shape (+): Creates a new shape from selected points.

You can also use the F key to create a new shape
from the selected points.

Delete Shape (×): Deletes the currently selected shapes.
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You can also use the Del key to delete selected
shapes.

Move Shape Up (↑) or Down (↓): Moves a shape up or down in the list.

The position of a shape in the list corresponds to its
drawing order.

The Selected Point section of the Calibration pane provides controls to modify the
properties of a selected point.

Original Position X/Y: Sets the position in pixels of the selected point in the
source-camera image.

Reset to Current Position: Sets the current position of the selected point as the
source position in the camera image.

Current Position X/Y: Sets the modified position in pixels of the selected
point.

Reset to Initial Position: Reverts the current position of the selected point to
the original position of the selected point.

The Selected Shape panel provides controls to modify the properties of a selected shape.
The points that are part of the shape also show their Point properties.

Name: Name of the shape.

Draw Mode: Determines how the shape is drawn and transforms the source image.

• "None" does not transform anything (disables a shape).
• "Move" moves the shape and leaves black where the

shape initially was.
• "Duplicate" copies the shape, leaving the original content

untouched, as opposed to "Move."
• "Mask" draws the shape all black.

Manual Blending

Unlike the Reverse Mapping tool, the 2D projector calibration tools—Warping and Edge
Warping—require manual blending. The Blending tool adds blending to the edges of
the selected projector. Blending should be used when more than one projector is display-
ing content in the same region on the surface. Blending allows the seamless and smooth
overlap between two projectors. Manual blending should not be used with Reverse
Mapping, because the Reverse Mapping tool already calculates blending.
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Figure I.27. Calibration layout—Manual Blending

Different blending properties can be defined for each of the projector's edges (left, right,
top, and bottom).

Brightness: Adjusts the brightness of the projected image

Contrast: Adjusts the contrast of the projected image

Force color: Projects the specified color instead of the projected image, for calib-
ration purposes

Gamma: Adjusts the gamma of the projected image

Gamma can be set individually for each color component (R, G, and
B). By default, all three components keep the same value when
changed. To disable this behavior, click on the link icon (similar to
scaling in 3D object properties).

Reset: Resets all the blending properties to their initial values

Edge-specific properties can also be set for a specific edge.

Enabled: Enables the blending for an edge

Width: Defines the width of the blending for the edge

Sharpness: Defines the sharpness of the blending for an edge

A higher sharpness results in a well-defined border for an edge's
blending, while a lower sharpness results in a smoother effect.
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Warping

The Warping tool applies distortions to the image projected by the camera. It can apply
small distortions, or it can warp an image to match a curved surface. With Perspective
Correction enabled, the Warping tool can also create a keystone effect in your image.
This tool can be used along with other calibration tools, but it should not be used to do
a full-screen keystone if Reverse Mapping is also used.

2D points created in the image can be moved, along with their tangents, and a Bezier
surface defined by the points is used to distort the image in a smooth way. Moving a
point or its tangents has an effect on the immediate vicinity of the point or its tangents.

This tool can be zoomed in or out and panned with the mouse wheel.

Figure I.28. Warping workflow layout
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Warping workflow

1. Select a preset that fits your needs. See Preset: in Warping controls (p.170).

2. Disable Perspective Correction if it is not needed, for example, if you
are using warping only to correct some content inaccuracies.

3. Create new points if needed with the right click menu or by using the
Ctrl+click shortcut.

A point cannot be created alone; it must be part of a row, a column, or
both. If a row or column already exists for a specific location, create
only the missing axis to avoid duplicate points.

4. Select points by clicking on them or dragging a selection box.

Selected points are shown in blue and display the tangent manipulators,
unselected points are shown in white. In perspective mode, corners
cannot be multi-selected. Points can be added to the selection using
the Shift key.

5. Move selected points with the mouse or arrow keys.

Selected points' manipulators can be moved to drag tangents. Lock and
symmetry options for the selected points' tangents can be set with icons
in the Selection section of the Calibration pane. See Tangent Lock: and
Tangent Symmetry: in Warping controls (p.170).

6. Set the positions manually, in pixels, for a single selected point and its
tangent in the Selected Point section of the Calibration pane.

7. Move the points and tangents until the projected image fits accurately.

8. Delete a selected point by pressing the Del key or using the right-click
menu.

As with point creation, a point cannot be deleted alone. A point must
be deleted with its row, its column, or both.

Warping controls

Subdivision Size: Determines the size of subdivisions use for the Bézier
surface.

The lower the size, the smoother the image will be.
Subdivision size can be set individually for X and Y
axes.

Show Wireframe: Toggles whether the wireframe is shown or not shown
when editing the warping.

Perspective Correction: Toggles whether the perspective is automatically
corrected or not when moving the corners of the
warping.
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Preset: Creates a default configuration of control points based
on a preset.

Points can be added or deleted from any preset. When
changing from one preset to another, the existing
warping is preserved as much as possible.

DescriptionPreset

Creates four points in the corners of the image.
Use this default preset to do a simple keystone.

Keystone

Creates four points in the corners of the image and two points at the
centers of the horizontal borders.
Use this preset to map a horizontally curved screen or cylinder.

Horizontal

Creates four points in the corners of the image and two points at the
centers of the vertical borders.
Use this preset to map a vertically curved screen or cylinder.

Vertical

Creates nine points resulting in the intersection of the horizontal and
vertical borders and centers.
Use this preset for more complex mapping (for example, a dome) or
image correction. More points will likely need to be added.

Grid

Table I.1. Warping control presets

Reset Recreates the original preset configuration of control points,
and resets the positions of the control points to their original
positions.

Tangent Lock: Locks the tangents of a control point, so that they are not ad-
justed when the control point or its neighbor is moved.

When locked, the tangents move if the control point is moved,
but they are not kept in the same relative orientation and
length from their neighbors. When unlocked, a tangent's length
and direction are adjusted to preserve the same relation to its
neighbor.

For example, when unlocked, a tangent that points directly
toward a neighbor—thereby creating no curve between the
point and the tangent—never creates a curve between a point
and its neighbor, when either the point or its neighbor is
moved.

Tangent Lock can be set independently for both horizontal
and vertical tangents.

Tangent Symmetry: Enables Tangent Symmetry, so that moving a tangent on the
axis also moves the opposite tangent symmetrically.

When enabling symmetry on non-symmetrical tangents, they
are adjusted so that they are symmetrical.
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Tangent Symmetry can be set independently for both horizont-
al and vertical tangents.

Warping shortcuts

Ctrl+Click: Creates a row and a column of control points at the
specified location.

Ctrl+Shift+Click: Creates a column of control points at the specified
location.

Ctrl+Alt+Click: Creates a row of control points at the specified loca-
tion.

Del: Deletes the selected control point with its row and
column.

Shift+Del: Deletes the selected control point with its column.

Alt+Del: Deletes the selected control point with its row.

Directional arrows: Moves the selected control points by one pixel in the
desired direction.

Shift+Directional arrows: Moves the selected control points by 10 pixels in the
desired direction.

Tab: Selects the next control point to the right.

Shift+Tab: Selects the next control point to the left.

Ctrl+Tab: Selects the next control point to the bottom.

Ctrl+Shift+Tab: Selects the next control point to the top.

I.4 Outputs layout
Use the Outputs layout to connect individual projectors and displays to the physical
outputs of the graphic cards on your Player computers. The Outputs layout also allows
you to tweak settings, such as the position of windows and the amount of anti-aliasing.

I.4.1 Outputs workflow layout

1. Click on each Display in the top part of the Outputs pane, and configure
its attributes—including its resolution and orientation—in the Properties
pane.

The top part of the Outputs pane is called the Display Map. See Display
Map (p.173).
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2. Click on Add Player and select the type of Player to add (based on the
number of outputs). Do this for as many Players as you need based on
the number of outputs required by your event and your Player license
limit.

3. Drag-and-drop the name of a Display onto one of the physical outputs
of a Player to connect a Display to the Player output.

4. Click on each Player and configure the attributes of the Player in the
Properties pane.

5. Click on the gear icon in the Display Map to show and modify the
global color correction settings, such as brightness and gamma.

Note

In X-Agora, a display can be connected to only one Player at a time. To
connect a Display to two Players, you must first copy that Display, and then
assign the copy to the second Player. You must also make sure that the
media you expect to play appears on this copy.

I.4.2 Displays

Display Map

The top part of the Output layout is the Display Map. It is a visual representation of all
the Displays (Projectors and Screens) in the current Projection Study of your 3D project.
For 2D projects, all the Displays are available, because there is no concept of Projection
Study. Displays can be moved around in this 2D map without any impact on their actual
output. This can be useful to group Projectors based on arbitrary categories or physical
connections.

When Players are running, their related Displays show periodically refreshed output
previews, so you can see the visual output from those Displays.

When you click on a Display, the Properties pane shows you all its attributes. When
this Display is assigned to a Player Output, the properties of this Player Output are also
shown.
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Figure I.29. Outputs Display pane

Display Map controls

Figure I.30. Display Map controls

The controls in the top-right corner of the display map allow the following operations:

Auto refresh: Updates automatically the low-resolution previews of active
Displays.

When this box is unchecked, a Refresh Preview button
appears, so that you may manually refresh these previews.

Auto fit: Fits all the Displays in one view.

Show thumbnail: Displays a zoomable map of all the Displays in the Display
Map.

Align to viewpoint: Aligns the Displays in the 2D map according to the Canvas
viewpoint defined in the Content Production tool. See
Content Production (p.130).

Show properties: Show the global Color Correction properties. See Color
Correction (p.187).

I.4.3 Display properties

In addition to its name, a Display has properties related to its orientation, resolution,
and model, which are shown in the Properties pane. projectors, LED screens, and LCD
screens each have their own properties on top of these, for example, for the projector
lens or LED pixel pitch.
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When it is attached to a Player Output, a Display also indicates the name of that Player
and the index of the output to which it is connected. It is also possible to access the
color correction properties of the Display.

Specifications

Technical information related to the model, resolution, orientation, attached Player,
LED pixel pitch, and screen brightness is displayed in the Specifications section of the
Properties pane. This information is typically entered in the Projection Study layout
during the early stages of a project.

Once a display has been attached to a Player, the name of that Player and the output
index of the attached display are also shown in this section.

Test Pattern

The Test Pattern section of the Properties pane has an Image property that can be used
to replace the Display's output with a predefined image. This can be helpful to ensure
that your physical displays' colors match or to quickly identify a physical projector on
site.

Output Correction

The following properties can be modified in the Output Correction section of the
Properties pane.

Object Mask (Projectors only): The Object Mask field provides a list of 3D objects that
can be used as masks for this projector. This is useful if you want a projector to never
project onto specific objects in your scene. The objects are always displayed in black.

PNG Mask: The PNG Mask field shows the file name of an image that can be displayed
as an overlay over the displayed content. This image must contain an alpha channel,
and therefore be in an image format that allows it, in this case PNG. A PNG mask is
useful for masking specific regions of content that are not 3D objects, or applying final
on-site feathering of overshooting regions. This image must be drag-and-dropped from
the Medias pane (as opposed to from Windows explorer), which can be shown (or hid-
den) by using a button next to this control.

Remap Image (Projectors only): A Remap Image allows per-Projector pixel remapping.
This texture contains information for where each pixel is supposed to be in the final
image. (Red and green stand for X and Y positions in the destination image.). This feature
allows you to perform advanced projector-specific adjustments that are impossible with
a PNG mask or regular Projector calibration. This image must be drag and dropped
from the Medias pane (as opposed to from Windows explorer), which can be shown
(or hidden) by using a button next to this control.

Dimmer: Dimmer allows you to adjust the value of the dimmer, between 0.0 (all black)
and 1.0 (no dimmer), for the Display.

Min Input: This is a minimum value to clamp the displayed color channels.
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Max Input: This is a maximum value to clamp the displayed color channels.

Hue Offset: Self-explanatory

Saturation: Self-explanatory

Brightness: Self-explanatory

Figure I.31. Outputs Properties pane for a projector
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Figure I.32. Outputs Properties pane for an LED display
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Figure I.33. Outputs Properties pane for an LCD display

I.4.4 Players

Players Map

The bottom part of the Output Control layout is the Players Map. It is a visual repres-
entation of all the Players in the current projection study. Players can be moved around
in this 2D map without any impact on their actual output. It can be useful to group
Players based on arbitrary categories or physical proximity. Figure X shows an example
of a Players Map.

Note

The Master Player, Player Center 1 in the figure, is shown differently than are
other Players. The background of the Master Player has a striped pattern.

Figure I.34. Outputs Players Map
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Player Types and Licenses: X-Agora Players with different numbers of outputs are
available. In order to launch X-Agora Player on a Player machine, its host needs to have
the right local license, either as an embedded software license or a physical USB dongle.
These licenses also restrict the number of physical live inputs that should be on a com-
puter. Runtime protection enforces these restrictions; if you try running a Player that
has more physical live inputs or more connected Player outputs than are allowed, the
Player closes and you are notified of the issue in X-Agora. See Licensing (p.29) for more
information on Licensing.

Player Status: A Player's status can be either “offline,” “ready,” or “playing.” A Player
is “offline” when the Player machine is turned off, X-Agora Agent is not running, or
the Player is not connected to the same X-Agora Server. When the X-Agora Agent con-
nection is established, the Player is “ready,” meaning that the Player can be launched.
Once a Player is launched, its status is “playing,” and its performance information and
preview are updated.

Player Performance: When a Player is running, it periodically sends performance in-
formation to X-Agora. You can access this detailed performance information by hovering
your cursor above each property and its related gauge.

The information available includes:

CPU usage average processor usage and processor usage per core

GPU usage graphics card name, load, and temperature

Memory usage combined random-access memory usage

Disk usage combined and partition-specific disk usage

SMPTE signal quality the real-time audio level of the SMPTE signal, if it is used

X-Agora performance software version, frame rate, application uptime, CPU
usage by X-Agora Player, and computer uptime

Figure I.35. Player performance
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Figure I.36. Player performance—

Individual Player controls

Shutdown

Restart

Wake-on-LAN (available only when the Player is offline)

Play/Stop (available only when the Player is ready and has outputs
connected to it)

Figure I.37. Player controls

Player Map controls

Figure I.38. Player Map controls

The controls in the top-right corner of the Player Map allow the following operations:
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All Logs: Displays all the information logged by X-Agora, including
useful debugging information for your project, the software,
or your licenses.

Sync All Players: Synchronizes the required logic and media files across all
Players, so that all of them have the resources to launch
your project.

Connect All Agents: Requests that the Agent for every “offline” Player in the
map connect to the Master Player. This makes the Players
“ready” if they are powered on. Machines that are powered
off can be powered on by using the WOL feature.

Auto fit: Fits all the Players in one view.

Show thumbnail: Displays a zoomable map of all the Displays in the map.

Add: Adds Players with the specified number of outputs to the
map, or automatically adds all detected Players on the
network.

I.4.5 Player properties

A Player has properties related to its physical host and connected projectors. These
properties are grouped into different expandable menus. Figure I.39, “Expandable menus
of the Player Properties pane” shows the expandable menus in the Properties pane.

Figure I.39. Expandable menus of the Player Properties pane
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Master Player

One player must be the Master Player. This is the computer on which the X-Agora
Server application runs. The Master Player also receives the SMPTE signal, if needed.
To quickly identify the Master Player in your map, look for the player with a striped
background pattern, as shown in Figure X.

Figure I.40. Master Player

Main properties

Name: A Player can be assigned a name, for mnemonic purposes.

Color: A Player can be assigned a color, which is assigned to all
its connected Displays.

Host: A Player runs on a physical machine, which must be refer-
enced here by using its host name or IP address.

Output Count: Select the number of physical outputs that are to be connec-
ted to this Player.

Licensing restricts the number of physical live inputs that
should be on a computer. See Player Types and Licenses in
Players Map (p.178), and see Licensing (p.29) for more inform-
ation on licensing.

Identify Monitors: Display an overlay on each monitor of this computer,
showing the X-Agora output index of that monitor.

Note

Monitors that are not connected to the optimal
GPU are not identified and cannot be used to
display Player windows.

Make Master Player: Make this machine the Master Player, to which all other
Players will connect. The media, logic, and 3D objects of
the project will be synced to this Player.
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Always running: Check this box to ensure that the Player is launched imme-
diately upon connecting to the Master Player, and also any
time it is closed. Use this feature in production so that your
show is launched automatically when you turn on the
computers on site.

Options menu

Advanced Player options for rendering are available in the Options menu of the Prop-
erties pane.

Figure I.41. Advanced Player Option menu

Anti Aliasing: Set the size of the anti-aliasing window (“none,”
“low,” “medium,” and “high”).

More anti-aliasing means more smoothing of sharp
lines.

Dedicated Fullscreen: Run all X-Agora Displays in a single X-Agora Player
window.

This evenly splits the X-Agora window into as many
outputs as are connected to the Player. This feature
is used to obtain the maximum performance results
of X-Agora Player. When the dedicated fullscreen
mode is enabled, only one Player window is
launched, but this window can span multiple screens
if you are using a manually configured AMD EyeFin-
ity Display Group.

Monitor (in Dedicated Full-
screen mode):

The field shows the index of the monitor that dis-
plays the X-Agora Player window. See Main proper-
ties (p.182).
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Custom Size (in Dedicated Full-
screen mode):

Force a custom resolution in Single Window Mode.

Always on top (in Dedicated
Fullscreen mode):

Determine whether or not the Player window ap-
pears on top of all other windows.

VSync: Check this box to enable vertical synchronization in
order to remove video tearing due to mismatches
between the screen refresh rate and the video feed
rate.

Use Fixed EDID: Use Extended Display Identification Data to force
the machine to use and remember the specified
monitor dimensions, even if no monitor is connected
to the graphic card's physical output.

Refresh Rate (Hz) (when VSync
is disabled):

Specify a target frame rate for X-Agora Player. Use
value 0 for the maximum frame rate possible.

Outputs

The Output menu—one for each Player—shows the Player Outputs that are assigned
a Display.

Figure I.42. Player Outputs

The following properties can be configured:

Mode: “Windowed” means that the Player appears in a
regular window with a frame, while “borderless” is
the same without a frame. “Fullscreen” means that
the Player takes up all of the monitor space.

Monitor: The field shows the X-Agora monitor index, which
can be identified with the toggle Identify Monitors.
(See Main properties (p.182).)

Always On Top: Check this box to force the X-Agora Player to appear
on top of all other windows.
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Top Left Corner (“borderless”
and “windowed” modes):

Specify the X and Y coordinates of the top left corner
of the Player on the monitor specified in the same
section.

Size (“borderless” and “win-
dowed” modes):

Choose from a list of common monitor resolutions
for the dimensions of the Player.

Custom size (“borderless” and
“windowed” modes):

Specify a non-standard Player resolution.

Genlock

This section of the Properties pane displays the support for generator locking a Player.

Live Input devices

X-Agora supports as many as four sources of live input on your Players. This section
presents a mapping from virtual devices (e.g., “Input 1”) to physical devices (shown in
the drop-down lists).

Figure I.43. Live inputs

You must define the mappings on all Players that will use live inputs.

When adding a live-input element to a timeline, you must choose which virtual device
to use for that element. The example shown in Figure I.44, “Sample Live-Input Timeline”
uses Input 1. Based on the list of live inputs in Figure I.43, “Live inputs”, this corresponds
to physical input 0 of the DeltaCast card on this machine. If the live-input element is
run on several Players, Input 1 could point to different physical cards and physical inputs.
This feature gives you the flexibility to use different inputs but address them with one
Timeline element.
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Figure I.44. Sample Live-Input Timeline

Audio devices

The Audio devices section of the Properties pane lists all the sound inputs on the Player
machine, and allows you to pick the input that is used for SMPTE, on the Master Player.
This list is refreshed upon booting the machine or reconnecting X-Agora Agent.

The SMPTE device can be picked only on the Master Player. The Master Player listens
to this SMPTE signal and attaches the playhead of the matching timeline to the audio
clock, sharing it through the X-Agora network to other Players.

If Auto is selected, the Master Player picks the first active sound input.

Sync

This section indicates whether or not the Player has been sent all the files (most crucially,
the media files) that are required to run the project. A button labeled Synchronize Scene
provides the option to perform that operation again. Refer to Player Map controls (p.180)
for information about synchronizing all the Players together.

I.4.6 Global Output Control properties

Click the gear icon in the Display Map (the top part of the Output layout) to show the
Global Output Control properties in the Properties pane. These properties allow global
modification of all of a player's outputs.
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Figure I.45. Global Color control

Color Correction

Note that if a Color Correction Action is used on a Timeline, the parameters of the action
override the values set here in Output Control. Color Correction adjustments for video
or image Timeline elements, however, are combined with these settings.

Gamma: the gamma correction factor

Min Input: the minimum input value (black)

Max Input: the maximum input value (white)

Hue Offset: the hue offset represented, as an angle between −180 and 180 on a hue
wheel

Saturation: the saturation boost factor, between −100% and +100%

Brightness: the brightness boost factor, between −100% and +100%

Reset resets the color correction properties to their default values.

I.5 Playback workflow layout
Use the Playback layout to play your show. It features a simplified interface for
streamlined playback, where Timelines are not editable to avoid accidental changes. It
also features the control room view of Player outputs, allowing you to monitor the
output and performance of your Player machines during operation.

I.5.1 Playback workflow

1. Start Players in the Players pane, if they are not already running.

2. Play Timelines.
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3. Monitor the visual outputs and performance of your Players.

I.5.2 Starting Players

The Players pane lists all of the Players of the current Projection Study, with controls
to individually start or stop each Player.

Above the list of Players, the Players pane offers global start and stop buttons to launch
or kill all Players.

Note

If a Player is marked as always running, it is launched as soon as its Agent
connects to the Master Player, or any time it is stopped.

Figure I.46. Playback layout—Players pane

I.5.3 Timeline control

Figure I.47. Timeline controls
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Timelines pane

The Timelines pane provides a list of all Timelines in your project. Each one can be
played, paused, or stopped with individual buttons. All Timelines can also be stopped
simultaneously by pressing the stop button at the top of the Timelines Pane. A second
global button allows filtering to show only Timelines that are playing or paused.

Timeline pane

When a Timeline is double-clicked in the Timelines pane, it is opened in the Timeline
pane. The following individual controls are displayed:

• Seek to the start of the timeline

• Move back one frame

• Start or pause the Timeline

• Move forward one frame

• Seek to the end of the timeline

Note

The length of a frame is determined by the frame rate of the Timeline. It is
also possible to move the playhead within individual Timelines with your
mouse cursor.

I.5.4 Monitoring outputs

The Outputs pane provides a preview of each output of each Player in the X-Agora
network. This allows you to validate that your Players are outputting visual content,
and it is particularly useful in a large show for which you can't physically see all the
outputs.

See Display Map (p.173) for an explanation of the Display Map and its controls.

I.5.5 Monitoring performance

You can monitor the performance of individual Players in the Playback layout as you
would monitor the performance of individual Players in the Outputs layout.
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Figure I.48. Playback performance
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Appendix J: More information
This section contains more information concerning keyboard shortcuts, audio and video
formats, and 3D-modelling formats.

J.1 Keyboard shortcuts

J.1.1 Viewport keyboard and mouse shortcuts

Manipulation of 3D objects

Rotate: r

Scale:: e

Translate: w

View: q

Viewport camera

Orbit: RMB

Pan: MMB

Reset View Home

Zoom: Scroll wheel

J.1.2 Timeline keyboard and mouse shortcuts

Keep the offset of dragged ele-
ments while changing layers:

Shift and drag the Timeline element

Panning in a Timeline MMB and drag

LMB+Space

Play/Pause Space

Select/deselect multiple Timeline
elements

Ctrl+LMB

Zoom in/Zoom out Mouse wheel

Ctrl+MMB provides more precision

Shift+MMB keeps left position of the Timeline while
zooming in or out

Zoom a specific part of the
Timeline

Alt and drag
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J.1.3 Global keyboard shortcuts

Redo Ctrl+y

Undo Ctrl+z

J.2 Supported 3D, audio, image, and video formats

J.2.1 Supported 3D formats

X-Agora supports .fbx, .obj, .dwg, .dxf, and .svg. Those file types can be separated in
two categories: modeling software formats (.fbx, .obj) and CAD drawing formats (.dwg,
.dxf and .svg). The most complete file format for X-Agora is .fbx, however you may not
have control over which of those formats can be used, because the models are usually
provided by an external source.

CAD drawing formats

CAD drawing formats (.dwg, .dxf and .svg) are usually made for architecture and
technical plans and are created by application like AutoCAD and Sketchup. These file
formats can contain either lines or faces. X-Agora can import both lines and faces, but
lines cannot be projected on. If you want to use such a file and project on it, have someone
with 3D-modeling software skills re-create the model with faces. Creating faces out of
lines in not a trivial task. If the projection surfaces are simple, or only screens are used
for projection, the lines can still be used as a reference, and simple 3D shapes or screens
can be created in X-Agora.

X-Agora stores no UV information for any CAD file format, therefore UV Sets in the
media elements properties will not work. To use the imported model as a projection
surface, the content must use projective texturing, or a Viewpoint must be created by
using the Content Production tool.

Modelling software formats

Modeling software formats (.fbx, .obj) are created by applications such as 3DS Max and
Cinema4D. These files almost always contain triangular faces. If they do not, most 3D-
modeling software allow you to easily export a file so that all faces are triangles. Models
made from these kinds of files can be projected in the same way as CAD drawing files
containing faces.

Modeling software format files can also contain UV information about how to apply
content to the object. The .obj format contains only a single UV set (UV Set 0). The .fbx
format can contain up to four different UV sets. These UV sets are usually created in
the modeling software by people who know how to create the UV sets, while also cre-
ating a template from the UVs in which the artists can work. To use a specific UV set
for a media element, it simply has to be selected in the media element properties.
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J.2.2 Supported audio formats

• WAV (Waveform Audio File Format) 16-bit 44.1 KHz

J.2.3 Supported image formats

X-Agora supports several image file formats, including...

• DPX

• JPG

• OpenEXR

• PNG

• TIFF

Image sequences can be converted to video files using X-Agora Media Encoder (p.127).

Note

The media encoder assumes media is gamma corrected (as opposed to
linear or log).

J.2.4 Supported video formats

X-Agora supports most common video formats and codecs, including...

• MPEG-2 and MPEG-4 (both the container and codec)

• Quicktime Animation

• Quicktime H.264

X-Agora uses FFMpeg to decode videos, and supports all its LPGL-compatible formats.
See 2.3, Video Codecs under General Documentation on the FFmpeg website (at ht-
tps://www.ffmpeg.org/).
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